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About This Manual 

 

What Is QuickField? 
Welcome to QuickField Finite Elements Analysis System. QuickField is a 
PC-oriented interactive environment for electromagnetic, thermal and stress analysis. 
Standard analysis types include: 

• Electrostatics. 
• Linear and nonlinear magnetostatics. 
• Time-harmonic magnetics (involving eddy current analysis). 
• Linear and nonlinear, steady state and transient heat transfer and diffusion. 
• Linear stress analysis. 
• Coupled problems. 

During a 15-minute session, you can describe the problem (geometry, material 
properties, sources and other conditions), obtain solution with high accuracy and 
analyze field details looking through full color picture. With QuickField, complicated 
field problems can be solved on your PC instead of large mainframes or workstations. 

How to Use this Manual 
This manual has nine chapters: 

Chapter 1, “Getting Started”, describes first steps of using QuickField. In this 
chapter, you will learn how to install and start the package. 

Chapter 2, “Introductory Guide”, briefly describes the organization of QuickField 
and gives an overview of analysis capabilities. 
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Chapter 3, “Problem Description”, explains how to specify the analysis type and 
general problem features. 

Chapter 4, “Model Geometry Definition”, explains how to describe geometry of the 
model, build the mesh, and define material properties and boundary conditions. 

Chapter 5, “Problem Parameters Description”, introduces non-geometric data file 
organization, and the way to attach this file to the model. 

Chapter 6, “Solving the Problem”, tells you how to start the solver to obtain analysis 
results. 

Chapter 7, “Analyzing Solution”, introduces QuickField Postprocessor, its features 
and capabilities. 

Chapter 8, “Theoretical Description”, contains mathematical formulations for all 
problem types that can be solved with QuickField. Read this chapter to learn if 
QuickField can solve your particular problem. 

Chapter 9, “Examples”, contains description of some example problems, which can 
be analyzed using QuickField. 

Conventions 
In this manual we use SMALL CAPITAL LETTERS to specify the names of keys on your 
keyboard. For example, ENTER, ESC, or ALT. Four arrows on the keyboard, 
collectively named the DIRECTION keys, are named for the direction the key points: UP 
ARROW, DOWN ARROW, RIGHT ARROW, and LEFT ARROW. 

A plus sign (+) between key names means to hold down the first key while you press 
the second key. A comma (,) between key names means to press the keys one after the 
other. 

Bold type is used for QuickField menu and dialog options. 
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C H A P T E R  1  

Getting Started 

Required Hardware Configuration 
 

Computer: Personal computer with a 486 or higher processor. 

Operating System: Microsoft Windows 95 or 
Microsoft Windows NT 4.0 Service Pack 3 or later 

Memory: 8MB minimum, 32MB recommended. Additional memory 
can improve performance for very huge problems. 

Video: VGA or higher-resolution video adapter (Super VGA, 
65536-color recommended). 

Mouse: Microsoft Mouse or compatible pointing device. 

Peripherals: A parallel port. 

QuickField Installation 
To install QuickField software on your computer: 

1. Insert disk labeled �QuickField Disk 1� into your floppy disk drive. 

2. Bring up Control Panel and double-click Add/Remove Programs. 

3. Follow the instructions on the screen. 

Now you can start QuickField from your Start menu. 
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When you start QuickField for the first time you will be requested to enter a 
password. The password is a 16-character length sequence of letters given to you on a 
sheet of paper with your QuickField package. The password is stored in the 
Password.txt file in your QuickField program files folder and will be used in all 
subsequent sessions. To change the password you can edit this file or make use of the 
Password command in the Edit menu, while all document windows in QuickField 
are closed. 

Note. To solve very large problems on a computer with insufficient memory it is 
essential that virtual memory is configured optimally. 

To manage virtual memory settings: 

1. Bring up Control Panel and double-click System. 

2. Switch to Performance tab. 

3. See Windows Help for details. 

Uninstalling QuickField 
To remove QuickField software from your system: 

1. Bring up Control Panel and double-click Add/Remove Programs. 

2. Select QuickField in the list of installed software. 

3. Click Add/Remove. 
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C H A P T E R  2  

Introductory Guide 

This chapter briefly describes the basic organization of the QuickField program. It 
presents an overview of the available capabilities. 

The aim of this chapter is to get you started with modeling in QuickField. If you are 
new to the QuickField, we strongly recommend you to study this chapter. If you 
haven't yet installed QuickField, please do so. For information on installing 
QuickField see Chapter 1. 

Basic Organization of QuickField 
In QuickField, you work with several types of documents: problems, geometry 
models, material libraries and so on. Each document is opened into a separate window 
within the main application window of QuickField. You can open any number of 
documents at once. When switching between windows, you switch from one 
document to another. Only one document and one window are active at a time, so you 
can edit the active document. Editing actions are listed in the menu residing on the top 
of main window of QuickField. Menu contents are different for different document 
types. You can also use context-specific menus, which are available by right-button 
mouse click on specific items in document window. 

The QuickField documents are: 

Problem corresponds to specific physical problem solved by QuickField. This 
document stores the general problem parameters, such as the type of analysis 
(�Electrostatics�, �Magnetostatics�, �Heat transfer� and etc.) or the model type 
(planar or axisymmetric). The detailed description of working with problems is given 
in Chapter 3. 
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Geometric Model is a complete description of the geometry, the part labels and the 
mesh of your model. Several problems may share the same model (this is particularly 
useful for coupling analysis). Editing models is described in details in Chapter 4. 

Property Description, or Data documents are specific to types of analysis 
(Electrostatics data, Stress Analysis data, etc.) These documents store the values of 
material properties, loadings and boundary conditions for different part labels. Data 
documents can be used as material libraries for many different problems. The detailed 
description of how to specify material properties and boundary conditions is given in 
Chapter 5. 

For the problem to be solved and analyzed, it must reference the model and data 
documents. For convenience, the problem can reference two data documents at once: 
one document containing properties for commonly used materials (material library), 
and another document containing data specific for the problem or group of problems. 

Between sessions, QuickField documents are stored in disk files, separate file for each 
document. During the session, you can create new documents or open existing ones. 
The detailed description of how to get and explore the results of the analysis is given 
in Chapter 6 and Chapter 7. 

Using this very flexible architecture, QuickField helps you build and analyze your 
design problems very quickly. In analyzing a problem, the typical sequence of phases 
that you go through with QuickField is depicted in the flowchart below: 
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Create new, empty problem

File: New: QuickField Problem

Specify the problem parameters

Edit: Properties

Define the geometry, part labels and
mesh for your model

Edit: Geometry Model

Provide data for the materials, loads
and boundary conditions

Edit: Data

Obtain the solution

Edit: Solve Problem

Review the results and obtain the
postprocessing parameters

Edit: Analyze Results
 

Window Management Tips 
QuickField is a Multiple Documents Interface (MDI) application, so you can work 
with several QuickField documents (problem descriptions, geometry models, data 
sets, etc.) at once. Dealing with specific documents will be discussed later in 
dedicated chapters, and now let�s discuss general principles of creating new 
documents, opening existing ones, switching between them and so on. 
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To create a new, empty QuickField document, you can: 

• Launch QuickField from your Start menu, and then click New in the 
QuickField�s File menu or use correspondent icon on QuickField toolbar. The 
dialog box appears asking you, which kind of QuickField document you want to 
create; or 

• Click right mouse button on your desktop (screen region not occupied by any 
application), and choose the kind of document in the context menu (thus creating 
the document on the desktop); or 

• Use Windows Explorer to select specific directory where you want new document 
to be created, and click New in the main menu or context menu of Explorer. 

To open an existing QuickField document, you can: 

• Double-click it in Windows Explorer or any file management utility; or 
• While QuickField is running, click Open in the QuickField�s File menu or click 

Open tool on QuickField�s toolbar; or 
• Drag the document�s icon from Explorer to any part of the QuickField window. 

To close the document, click Close in the File menu, or click Close icon on the 
document�s window frame. If the document has been changed since last save, you 
will be asked to save the changes to file. 

To switch between windows within QuickField, press CTRL+TAB or click on any 
visible part of the window you want to switch to. 

Once the document is open, its window can be minimized to an icon, maximized to 
the full size of QuickField window, or brought to �normal� size, which you can 
change by dragging the window�s corners. This is particularly useful when you want 
to see several documents at once. Also you can automatically arrange all 
non-minimized windows side-by-side by clicking Tile Horizontally or Tile 
Vertically in the Window menu. 

Some windows can be split up to four separate panes. To split window you can point 
the splitter box � small gray box appears at the top of the vertical scroll bar or at the 
left side of the horizontal one. When the mouse pointer changes its form drag the 
splitter bar to the position you want. You can use also Split Window command in the 
Windows menu. To switch between panes simply click the desired one or press F6 
key. 

To return to a single window double click the split bar or point it and drag until it 
disappears. 
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Overview of Analysis Capabilities 
This section provides you with the basic information on different analysis capabilities. 
For detailed formulations of these capabilities see Chapter 8. 

Magnetostatic Analysis 
Magnetic analysis is used to design or analyze variety of devices such as solenoids, 
electric motors, magnetic shields, permanent magnets, magnetic disk drives, and so 
forth. Generally the quantities of interest in magnetostatic analysis are magnetic flux 
density, field intensity, forces, torques, inductance, and flux linkage. 

QuickField can perform linear and nonlinear magnetostatic analysis for 2-D and 
axisymmetric models. The program is based on a vector potential formulation. 
Following options are available for magnetic analysis: 

Material properties: air, orthotropic materials with constant permeability, 
ferromagnets, current carrying conductors, and permanent magnets. B-H curves for 
ferromagnets can easily be defined through an interactive curve editor, see the 
“Editing the Curves” section in Chapter 5. 

Loading sources: current or current density, uniform external field and permanent 
magnets. 

Boundary conditions: Prescribed potential values (Dirichlet condition), prescribed 
values for tangential flux density (Neumann condition), constant potential constraint 
for zero normal flux conditions on the surface of superconductor. 

Postprocessing results: magnetic potential, flux density, field intensity, forces, 
torques, magnetic energy, flux linkage, self and mutual inductances. 

Special features: A postprocessing calculator is available for evaluating user-defined 
integrals on given curves and surfaces. The magnetic forces can be used for stress 
analysis on any existing part (magneto-structural coupling) . A self-descriptive 
inductance wizard is available for easily calculation of self- and mutual inductance of 
your coils. 

Time-Harmonic Electromagnetic Analysis 
Time-harmonic electromagnetic analysis is used to analyze magnetic field caused by 
alternating currents and, vise versa, electric currents induced by alternating magnetic 
field (eddy currents). This kind of analysis is useful with different inductor devices, 



10 Chapter 2  Introductory Guide 

solenoids, electric motors, and so forth. Generally the quantities of interest in 
harmonic magnetic analysis are electric current (and its source and induced 
component), voltage, generated Joule heat, magnetic flux density, field intensity, 
forces, torques, impedance and inductance. 

Following options are available for harmonic magnetic analysis: 

Material properties: air, orthotropic materials with constant permeability, current 
carrying conductors with known current or voltage. 

Loading sources: voltage, total current, current density, uniform external field. 

Boundary conditions: Prescribed potential values (Dirichlet condition), prescribed 
values for tangential flux density (Neumann condition), constant potential constraint 
for zero normal flux conditions on the surface of superconductor. 

Postprocessing results: magnetic potential, current density, voltage, flux density, 
field intensity, forces, torques, Joule heat, magnetic energy, impedances, self and 
mutual inductances. 

Special features: A postprocessing calculator is available for evaluating user-defined 
integrals on given curves and surfaces. The magnetic forces can be used for stress 
analysis on any existing part (magneto-structural coupling); and power losses can be 
used as heat sources for thermal analysis (electro-thermal coupling). Two 
self-descriptive wizards are available: one of them for easily calculation of mutual 
and self inductance of your coils and the second for calculation of the impedance. 

Electrostatic Analysis 
Electrostatic analysis is used to design or analyze variety of capacitive systems such 
as fuses, transmission lines and so forth. Generally the quantities of interest in 
electrostatic analysis are voltages, electric fields, capacitances, and electric forces. 

QuickField can perform linear electrostatic analysis for 2-D and axisymmetric 
models. The program is based on Poisson's equation. Following options are available 
for electrostatic analysis: 

Material properties: air, orthotropic materials with constant permittivity. 

Loading sources: Voltages, and electric charge density. 
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Boundary conditions: Prescribed potential values (Voltages), prescribed values for 
normal derivatives (surface charges), and prescribed constraints for constant potential 
boundaries with given total charges. 

Postprocessing results: voltages, electric fields, gradients of electric field, flux 
densities (electric displacements), surface charges, self and mutual capacitances, 
forces, torques, and electric energy. 

Special features: A postprocessing calculator is available for evaluating user-defined 
integrals on given curves and surfaces. Floating conductors with unknown voltages 
and given charges can be modeled. The electrostatic forces can be used for stresses on 
any existing part (electro-structural coupling).. A self-descriptive capacitance wizard 
is available for easily calculation of self- and mutual capacitance of your conductors. 

Current Flow Analysis 
Current flow analysis is used to analyze variety of conductive systems. Generally the 
quantities of interest in current flow analysis are voltages, current densities, electric 
power losses (Joule heat). 

QuickField can perform linear current flow analysis for 2-D and axisymmetric 
models. The program is based on Poisson's equation. Following options are available 
for current flow analysis: 

Material properties: orthotropic materials with constant resistivity. 

Loading sources: Voltages, electric current density. 

Boundary conditions: Prescribed potential values (Voltages), prescribed values for 
normal derivatives (surface current densities), and prescribed constraints for constant 
potential boundaries. 

Postprocessing results: voltages, current densities, electric fields, electric current 
through a surface, and power losses. 

Special features: A postprocessing calculator is available for evaluating user-defined 
integrals on given curves and surfaces. The electric power losses can be used as heat 
sources for thermal analysis (electro-thermal coupling). 

Thermal Analysis 
Thermal analysis plays an important role in design of many different mechanical and 
electrical systems. Generally the quantities of interest in thermal analysis are 
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temperature distribution, thermal gradients, and heat losses. Transient analysis allows 
you to simulate transition of heat distribution between two heating states of a system. 

QuickField can perform linear and nonlinear thermal analysis for 2-D and 
axisymmetric models. The program is based on heat conduction equation with 
convection and radiation boundary conditions. Following options are available for 
thermal analysis: 

Material properties: orthotropic materials with constant thermal conductivity, 
isotropic temperature dependent conductivities, temperature dependent specific heat. 

Loading sources: constant and temperature dependent volume heat densities, 
convective and radiative sources, Joule heat sources imported from current flow 
analysis. 

Boundary conditions: Prescribed temperatures, boundary heat flows, convection, 
radiation, and prescribed constraints for constant temperature boundaries. 

Postprocessing results: temperatures, thermal gradients, heat flux densities, and total 
heat losses or gains on a given part; with transient analysis: graphs and tables of time 
dependency of any quantity in any given point of a region. 

Special features: A postprocessing calculator is available for evaluating user-defined 
integrals on given curves and surfaces. Plate models with varying thickness can be 
used for thermal analysis. The temperatures can be used for thermal stress analysis 
(thermo-structural coupling). Special type of inter-problem link is provided to import 
temperature distribution from another problem as initial state for transient thermal 
analysis.  

Stress Analysis 
Stress analysis plays an important role in design of many different mechanical and 
electrical components. Generally the quantities of interest in stress analysis are 
displacements, strains and different components of stresses. 

QuickField can perform linear stress analysis for 2-D plane stress, plane strain, and 
axisymmetric models. The program is based on Navier equations of elasticity. 
Following options are available for stress analysis: 

Material properties: isotropic and orthotropic materials. 

Loading sources: concentrated loads, body forces, pressure, thermal strains, and 
imported electric or magnetic forces from electrostatic or magnetostatic analysis. 
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Boundary conditions: prescribed displacements, elastic spring supports. 

Postprocessing results: displacements, stress components, principal stresses, von 
Mises stress, Tresca, Mohr-Coulomb, Drucker-Prager, and Hill criteria. 
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C H A P T E R  3  

Problem Description 

Structure of Problem Database 
A special database is built for each problem solved with QuickField. The core of the 
database is the problem description, which is stored in file with the extension .pbm. 
The problem description contains the basics of the problem: its subject, plane, 
precision class, etc., and also references to all other files, which constitute the 
problem database. These files are the model file, with standard extension .mod, and 
physical data (property description) files, with extension .dms, .dhe, .des, .dcf, .dht, 
or .dsa, depending on the subject of the problem. 

The problem description may refer to one or two files of physical data. Both files 
have the same format, and differ only in purpose. Usually, the first data file contains 
specific data related to the problem, as the second file is a library of standard material 
properties and boundary conditions, which are common for a whole class of 
problems. 

Depending on the problem type, you may share a single model file or a single data 
file between several similar problems. 

While solving the problem, QuickField creates one more file�the file of results with 
the extension .res. This file always has the same name as the problem description file, 
and is stored in the same folder. 

Editing Problems 
• To create a new, empty problem description, click New in the File menu and then 

select QuickField problem in the list that appears. Then enter the name and path 
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of the new problem. You can also create a new problem as a copy of an another 
problem being currently opened. In that case new problem inherits all the 
properties of the sample one and the referenced model and data documents are 
copied if necessary. 

• To open an existing document, click Open in the File menu, or use drag and drop 
features of Windows. 

Open problem documents are shown in a special view to the left of main QuickField 
window. In problem view, you can edit problem description options and references to 
files. The tree shows the names of files, which the problem currently references. 

• To change problem settings or file names, click Properties in the Edit menu or 
context (right mouse button) menu. 

• To start editing a referenced document (model, data, secondary data or other 
problem referenced as coupling link), double-click its name in the tree, or click 
Edit File in the context menu, or click correspondent item in Edit menu. 

• To solve the problem, click Solve Problem in the Edit menu or context (right 
mouse button) menu. 

• To analyze the results, click View Results in the Edit menu or context menu. 

Editing problem description properties 

 

Problem type: Select the type of analysis, which your problem belongs to. 

Model class: Select the geometry class of your model: plane or axisymmetric. 

Precision: Select the precision you need. Note that higher precision leads to longer 
solution time. 
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Formulation: Select the formulation of planar stress analysis problem. 

Frequency: Type the value of frequency for the time-harmonic magnetics problem. 
Note the difference between frequency f and angular frequency ω: ω = 2πf. 

Files: Edit the file names of your model and data files. You may use long file names. 
If the name is given without the full path, it is assumed with respect to the problem 
description file. You can also click Browse to select file in any folder on your hard 
disk or the network. 

Edit: Instantly loads selected file into the new QuickField window. 

Establishing Coupling Links 
The stress analysis and heat transfer problems can incorporate data, which come from 
other analysis types. The data types are: electrostatic and/or magnetic forces and 
temperature field for the stress analysis, and power losses generated by the current 
flow for the heat transfer. Transient heat transfer problems can import initial state of 
temperature distribution from another steady state or transient heat transfer problem 
(at specified time moment in latter case). 

To establish a link between the problem that imports data and the problem that 
originates them, click Links tab in problem description dialog box. 

 

To add a data link: 

1. Select the type of the data in the Data Type list; 

2. Type a name of the source problem in the Problem box, or click Browse button to 
make the selection from the list of existing problems; 
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3. In case the source problem is of transient analysis type, specify the time moment 
you wish to import in the Time field; if this specific time layer does not exist in 
the results file, the closest time layer will be imported; 

4. And, click Add button to add the link to the list of data sources. 

To change a data link: 

1. Select the link of choice in the Data Sources list; 

2. Change the source problem name or the moment of time as necessary; 

3. And, choose Update button to update the link in the list of data sources. 

To delete a link: 

1. Select the link of choice in the Data Sources list box; 

2. And, click Delete button to delete the link from the list of data sources, or use 
Delete All button to delete all data links at once. 

The links to the imported data are considered to be a part of the problem description. 
The changes made in them are preserved only if you choose OK when completing the 
problem description editing. And, vice versa, if you would choose Cancel button or 
press ESC, the changes made in data links will be discarded along with other changes 
in problem description. 
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Setting Time Parameters 
With problems of transient analysis type, you need to set up the time parameters, 
before the problem can be solved. To do so, click Timing tab in the problem 
description dialog box. 

 

Calculate up to: Specify the period of time you wish to simulate. Simulation always 
starts at �zero� time moment. 

With the step of: Specify the step size for the calculation. In transient analysis, this is 
the most important parameter controlling the precision of calculations in time domain: 
the smaller the step, the better the precision. Usually you will have minimum of 15 to 
20 steps for the whole integration period. It may have sense to start with bigger value 
of this parameter and then decrease it if the result seems to change not smoothly 
enough. 

If for some model you cannot estimate suitable time parameters, we recommend that 
you set some arbitrary value for the time period, and set the step size to have 5-7 
points of integration, and then explore the X-Y plots against time in several points in 
the domain to tune the parameters. 

Store the results every: defines the time increment for saving the results of 
calculation to the file. This value must be equal or greater than the step size. 

Starting from the moment: defines the first point to be written to the file. If this 
value is zero, the initial state will be written. 
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Choosing Length Units 
QuickField allows you to use various units for coordinates when creating model's 
geometry. You can use microns, millimeters, centimeters, meters, kilometers, inches, 
feet, or miles. To set the units of preference, choose Coordinates tab in problem 
description dialog box. 

Chosen units are associated with each particular problem, which gives you freedom to 
use different units for different problems. Usually units of length are chosen before 
creating the model geometry. It is possible to change units of length later, but it does 
not affect physical dimensions of the model. So, if you create your geometry as a 
square with 1 m side and then switch to centimeters, you will get a square measured 
100 cm by 100 cm, which is the same as it was before. To actually change size of the 
model you should rather use Scaling option of the Move Selection command of the 
Model Editor (see page 27 for details). 

The choice of length units does not affect units for other physical parameters, which 
always use standard SI units. E.g., the current density is always measured in A/m2 and 
never in A/mm2. The only physical quantity that is measured in chosen units of 
length, is the displacement vector in stress analysis problems. 

Cartesian vs. Polar Coordinates 
Problem geometry as well as material properties and boundary conditions can be 
defined in Cartesian or polar coordinate systems. There are several places in 
QuickField where you can make choice between Cartesian and polar coordinate 
systems. Using Coordinates tab in problem description dialog box you can define the 
default coordinate system associated with a problem. The same option is also 
available in the Model Editor and in the Postprocessor. Definition of orthotropic 
material properties, some loads and boundary conditions depends on the choice of the 
coordinate system. You can choose Cartesian or polar coordinate system for each 
element of data individually and independently from the default coordinate system 
associated with the problem. This choice is available in the dialog boxes of the Data 
Editor. 
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Model Geometry Definition 

This chapter describes the process of building the geometric model�a type of 
QuickField document describing the problem geometry. It contains specific geometric 
objects and establishes the correspondence between the objects and material 
properties, field sources and boundary conditions 

Terminology 
Vertex, edge and block are three basic types of geometric objects, which constitute the 
model in QuickField. 

Vertex is a point on the plane with coordinates defined by the user or calculated 
automatically as intersection of the edges. For each vertex you can define the mesh 
spacing value and the label. The mesh spacing value defines approximate distance 
between mesh nodes in the neighborhood of the vertex. The label is used, for 
example, to describe a line source or load. 

Edge is a line segment or a circular arc connecting two vertices. It can't intersect any 
other edge of the region. If an edge being created contains an existing vertex, two 
adjacent edges are created. New vertices are automatically created in all points where 
new edge intersects the existing ones and all intersected edges are split by these 
vertices. Edges can be labeled, for example, to specify the boundary conditions. 

Block is a continuous subregion with its boundary consisting of edges and possibly 
isolated vertices. A block may contain holes that can be formed by chains of edges or 
by isolated vertices. Each block has to be labeled to describe material properties. 
Labels of the blocks are also used to define distributed field sources. Unlabeled block 
is not included in calculation of field even it is covered by the mesh. The mesh is 
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created block by block automatically or according to the mesh spacing value defined 
for particular vertices. 

The Label is a string of up to 16-character length, which establishes the 
correspondence between geometrical parts of the model and physical values assigned 
to them. Any printable characters including letters, digits, punctuation marks, space 
character are permitted, except for asterisk (∗ ) and question mark (?) characters. The 
label cannot begin with space character; trailing spaces are ignored. Labels are 
case-sensitive. 

The Mesh Spacing value defines an approximate element size around the vertex. The 
mesh spacing parameter is associated with the vertex and measured in the current 
units of length. By setting mesh spacing values in some vertices you can control the 
mesh density and therefore the accuracy of the solution. 

How to Create a Model 
Model development consists of three stages: 

• Geometry description; 
• Definition of properties, field sources and boundary conditions; 
• Mesh generation. 

To describe model geometry you define vertices and edges, which form boundaries of 
all subregions having different physical properties. You can create vertices and edges; 
move, copy and delete any geometric object. To perform editing actions upon several 
objects at once, you can use selection mechanism. 

You define properties, sources and boundary conditions by means of assigning labels 
to geometrical objects. 

There are two options available for creating the finite element mesh for your model: 

• Fully automated method which generates a smooth mesh with a density based on 
region's dimensions and sizes of geometrical details. This option does not require 
any information from the user. 

• The second method allows you to choose the mesh density. In this case you need 
to define the spacing values at few vertices of your choice. Spacing values for 
other vertices are calculated automatically to make the mesh distribution smooth. 
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Creating Edges 
To create new edges: 

1. In the Edit menu or context (right mouse button) menu, click Insert Mode to 
switch the view into insert mode. 

2. Use pull-down list box in the Model toolbar to choose new edge type (line 
segment or arc) and the arc angle�you may use predefined angles listed or type 
different value; zero angle corresponds to line segment. 

3. Drag the mouse with left button pressed or use SHIFT+DIRECTION keys to drag 
the cursor from starting to ending point of the edge. You can use existing vertices 
as well as create new vertices while creating edges. If snap to grid feature is 
active, new vertices can be created only on grid nodes. 

4. Please don�t forget to switch the insert mode off after finishing insertion�
otherwise you can easily insert unwanted objects! 

Creating Vertices 
To create new vertices: 

1. In the Edit menu or context (right mouse button) menu, click Insert Mode to 
switch the view into insert mode. 

2. Make sure that current coordinate grid settings fit coordinates of vertices you 
want to create. 

3. Just use mouse or DIRECTION keys to move the cursor to point where you want 
new vertex to appear and double-click left mouse button or press ENTER. 

4. Please don�t forget to switch the insert mode off after finishing insertion�
otherwise you can easily insert unwanted objects! 

Or: 

1. In the Edit menu, click Add Vertices. 

2. Enter new vertex coordinates and click Add. Repeat if you need more vertices. 

3. Click Close. 

Objects Selection 
To select geometric objects: 

1. Make sure that insert mode is off. 
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2. Click objects you want to select with SHIFT or CTRL key pressed, or click and 
drag diagonally to select several connected objects at once. In latter case, only 
those objects are selected that entirely fit in the selection rectangle. 

You also may use Select All and Unselect All commands in the Edit or context 
menu. Note that you can select objects of different types (blocks, edges or vertices) at 
once. 

Copying and Moving Geometric Objects 
Repeated geometry elements can be easily created by means of copying any set of 
objects to new location, using geometric transformations listed below. To make a 
copy: 

1. Select any number of objects (vertices, edges and blocks) you want to copy, 
choosing Select from the menu. 

2. In the Edit menu or context menu, click Duplicate Selection. The dialog box 
appears, asking for copying parameters. 

3. Select transformation, enter its parameters and click OK. The new objects will 
appear on screen and the program will be waiting for your confirmation, so you 
could be sure that you entered the parameters correctly. 

4. Click Yes to confirm copying. New objects will be �implanted� into the model, 
and selection will move to the last copy. 

The copy operation affects all explicitly set features of the selected objects, including 
labels and spacing values. Only the mesh is not copied. 

Caution. Use copy operation with care, because improperly set transformation 
parameters may cause creating new objects in the wrong places. Such improper 
objects may interfere with the existing objects and generate a lot of useless 
intersection points, which will be hard to remove later. 

You can also move selected objects to other location with the restriction that region 
topology will not change, and no new intersection or coinciding will arise. To move 
selected objects, click Move Selection in the Edit menu or context menu. The dialog 
box that appears is very similar to Copy Selection dialog box. 
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Geometric transformations available with move and copy operations are: 

Displacement� parallel displacement is applied to selected objects for specified 
displacement vector. With copy operation, several copies can be 
asked for, it means that copying operation will be performed several 
times, each time being applied to the previous result. Parameters 
needed are displacement vector components. 

Rotation � selected objects are rotated around the specified point for the 
specified angle. With copy operation, several copies can be asked 
for, it means that copying operation will be performed several 
times, each time being applied to the previous result. Parameters 
needed are center of rotation coordinates and angle measured in 
degrees. 

Symmetry � selected objects are mirrored; symmetry line is specified by 
coordinates of any point on it and the angle between the horizontal 
axis and the symmetry line. Positive value of an angle means 
counter-clockwise direction. This transformation is available for 
copy operation only. 

Scaling � selected objects are dilated (constricted) by means of homothetic 
transformation. Parameters needed are center of homothety and 
scaling factor. This transformation is available for move operation 
only. 

Deleting Objects 
To delete geometric objects: 

1. Select objects you want to delete. 

2. In the Edit menu or context menu, click Delete Selection. 

If the selection contains vertices only and the vertex being removed connects exactly 
two edges, which can be treated as single edge when eliminating that vertex, those are 
joined together. Otherwise confirmation will be asked to delete all the connected 
edges. 
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Attraction Distance Parameter 
To avoid small unrecognizable inaccuracies in geometry definition, new vertices or 
edges cannot be created very close to the existing ones. The creation of new 
geometric objects is controlled by the ε parameter also called the attraction distance. 

The following rules concern creating new vertices and edges. 

• Creating a new vertex is prohibited within 2ε-neighborhood of the existing one. 
• A new edge cannot be added if it joins the same vertices as of an existing edge and 

the maximum gap between them does not exceed ε. 
• If the distance between a vertex to add and some edge is less than or equal ε, the 

vertex is attracted by the edge and the edge is automatically split into pair of new 
edges to incorporate the vertex. The same is true when new edge is added, but in 
this case the new edge may be attracted by existing vertex. 

The value of ε is 0.5 per cent of the visible region size, so to create very small details 
you have to zoom in the window. 

Labeling Vertices, Edges and Blocks 
The correspondence between geometrical objects and their physical properties, such 
as material properties, boundary conditions, or field sources is established by the use 
of labels. 

To assign label: 

1. Select objects you plan to give the same label 

2. In the Edit menu or context menu, click Properties, the dialog box appears. 

3. In Label list, type in the label or choose the label among existing ones. Then click 
OK. 

If you select objects of different type at once, you can set labels to selected objects of 
each kind (blocks, or edges, or vertices) separately on different pages of Property 
dialog. 

Meshing Technology 
After creating the geometry of the model or its parts, you can proceed with building 
the finite element mesh. You can easily build a nonuniform mesh for a highly 
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complex geometry. You may choose a fine mesh in some regions and very coarse in 
others, since the geometric decomposition technique would produce a smooth 
transition from large to small element sizes. Generally, the mesh has to be fine where 
the field changes most rapidly (high gradient), and also where you need high 
precision. 

If the geometry is rather simple, or a draft precision for preliminary design analysis is 
satisfactory, it is suggested to use the fully automatic mode to create the mesh. With 
this option, once you built your geometry you would simply click Build Mesh and a 
suitable mesh is automatically created without any information on the mesh size. 

You also have the option to pick the mesh density if you choose to do so. The mesh 
density is controlled by spacing values in vertices. The spacing value defines 
approximate distance between mesh nodes around that vertex. You never need to 
define the spacing in all model's vertices. To obtain uniform mesh you can set the 
spacing in any one vertex. This value is spread among all other vertices automatically. 
If you need the non-uniform mesh, define spacing values only in those vertices where 
you need finest and roughest mesh. The spacing values are automatically interpolated 
to other vertices to smooth the mesh density distribution. The group selection 
mechanism allows assigning the value to several vertices at once. 

After defining spacing values, you can proceed with the mesh building. The mesh is 
built block by block. You may choose to build the mesh in one block or in selected 
blocks or in entire region at once. 

Changing the density of a pre-built mesh (e.g. if solution results show that you need 
more precision somewhere in the region) obey some rules: 

• When you change the spacing value in some vertex, the mesh is removed 
automatically in those blocks, which are connected to that vertex. 

The mesh that is not removed, freezes spacing values along its boundary from 
recalculation as if those values were defined manually; so if you need major changes 
in the mesh density, first remove the mesh in the whole region. 

To set mesh spacing: 

1. Select vertices, edges or blocks, in neighborhood of which you need to specify the 
same spacing value. 

2. In the Edit menu or context menu, click Properties. 

3. Type in the spacing value or choose it from the list of already defined values, and 
then click OK. 
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If you choose to specify mesh spacing while selecting blocks or edges, the spacing 
value is actually assigned to all the vertices located on those edges or block 
boundaries. 

To build the mesh: 

• In the Edit menu or context (right mouse button) menu, click Build Mesh and then 
click appropriate option from submenu that appears. 

• Or, select Build Mesh button on the toolbar. In this case the domain for building 
mesh is selected in following order: 
• In selected blocks, if any; 
• In labeled blocks, if any; 
• In all blocks in the region. 

To remove the mesh: 

• In the Edit menu or context (right mouse button) menu, click Remove Mesh. 
Then click appropriate option from submenu. 

• Or, select Remove Mesh button on the toolbar. In this case the mesh is removed 
from selected blocks, if any, or from all meshed blocks. 

If the spacing visibility switch is on (Spacing in View menu), the explicitly set 
spacing values are shown as small circles around the vertices. You can see the mesh 
building process if Mesh toggle in View menu is on. 

Tuning the Picture in Model View 
There are several options you can change to adjust the picture to best suit the task you 
are currently performing: 

• Scaling the picture (zoom) gives you the ability to see more or less of your 
model to deal with small or large objects. 

• Switching visibility of model details makes the picture more suitable to perform 
specific stage of model creating. 

• Background grid makes the process of creating model vertices and edges easier 
and safer. 

You also can open several windows for the same model and set different scaling 
factor and details visibility in each of them. To do so, click New Window in the 
Window menu. 
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Zooming 
To magnify the picture: 

1. Click Zoom In button in the model toolbar 

2. Select the rectangle (click and drag diagonally), which then will occupy the whole 
window. 

To see more of the model: 

• Click Zoom Out button in the model toolbar. 
• Or, click Zoom to Fit to see the whole model. 

Model Discretization Visibility 
There are four switches Mesh, Domain, Breaking, and Spacing which control the 
discretization visibility level. These are accessible in the View menu. When all these 
switches are off, region is displayed without discretization. This mode is useful for 
region geometry description and label setting. If the Spacing mode is switched on, all 
explicitly set spacing values are shown as circles with the appropriate radii. 

When Breaking switch is on, the size of the elements along the edges is shown as tic 
marks on the edges. It is convenient to use both Spacing and Breaking when 
specifying the mesh spacing values. Mesh lets you see the complete triangular mesh. 
Turn it on to check the mesh building process. Domain without Mesh displays the 
domains due to geometric decomposition process. 

Background Grid 
Using the grid makes the process of creating model vertices and edges easier and 
helps to check the model. To change the grid, click Grid Settings in the Edit menu or 
context (right mouse button) menu. 
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Snap to Grid switches grid attraction on and off. Attraction means that mouse clicks 
create new vertices only at grid nodes making model description more fast and safe. 

Show Grid switches on and off grid visibility. 

Edit Spacing to change the grid density. To apply different horizontal and vertical 
spacing, first check the Anisotropic box. 

Editing Origin gives you the ability to create vertices at even distances from certain 
point, which coordinates you enter here. 

DXF File Import 
You can import model geometry or its fragments from the DXF file produced by any 
major CAD system. To do so, choose Import DXF in the File menu and then type or 
select required file name. The visible region is automatically extended if needed to 
assure visibility of all imported geometric objects. If the model is not empty when 
reading the DXF file, it is recommended to save the current model�s state before the 
operation. This will give you a chance to return to the initial stage if the imported 
objects incidentally overlap the existing part of model. 

DXF File Export 
You can export model geometry or its fragments to the DXF file that can be read by 
any major CAD system or by QuickField itself . To do so, choose Export DXF in the 
File menu and then type or select required file name. If some geometrical objects in 
the model are selected, you can click appropriate button to choose whether to export 
the entire model or the selection only. 

Printing the Model 
You can directly print the model picture to your local or network printer, just as you 
see the model in the window, with the same zooming and discretization visibility. 
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• To print the picture, click Print in the File menu. You will have an option to 
choose the printer and set up the picture, such as paper size and orientation, before 
printing will occur. 

• To preview the output before printing, click Print Preview in the File menu. To 
see how the picture will appear on a printer of your choice, click Print Setup 
before. 

Copying the Model Picture 
You can copy the model picture, as you see it in the window, to clipboard, for 
subsequent including it to your paper or report in any word-processing or desktop 
publishing utility. 

• To copy the picture, click Copy Picture in the Edit menu, or press CTRL+INS. 
• Switch to the application where you want to paste the picture and click Paste in 

the Edit menu, or press SHIFT+INS.. 
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Problem Parameters Description 

To solve the problem it is needed to describe the material properties, field sources and 
boundary conditions. These parameters are stored in the property description 
documents. The correspondence between records of these files and subdomains or 
boundaries of the region is established by the labels assigned to geometrical objects 
during editing the model. Labeling blocks, edges and vertices is described in 
Chapter 4 "Model Geometry Definition". 

The document consists of labels divided into three groups: 

• block labels describe material properties and loads for subregions of the model; 
• edge labels assign specific boundary conditions to your model�s boundaries; 
• vertex labels describe singular sources or constraints applied to points of your 

model. 

Property description documents are specific to types of analysis. Each document 
occupies separate QuickField window and is stored in a separate disk file. File 
extensions are also specific to disciplines: 

Kind of analysis File extension 
Magnetostatics .dms 
Time-harmonic magnetics .dhe 
Electrostatics .des 
Current flow .dcf 
Heat transfer .dht 
Stress analysis .dsa 

• To create a new property description, click New in the File menu and then select 
appropriate type of document in the list that appears. 

• To open existing document, click Open in the File menu, or use drag and drop 
features of Windows, or, while working with problem description, double-click 
the name of associated property description file. 
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Editing material properties and boundary conditions 
Once the property description document is opened, a new window appears in 
QuickField application window, displaying the structure of the document. The tree 
shows labels assigned to blocks, edges and vertices. 

Icons displayed by the labels mean: 

 Block label with specified material properties 
 Edge label with specified boundary condition 
 Vertex label with specified boundary condition 

or source 

 

Label referenced in models not yet given the 
properties 

 Empty block label excluded from 
consideration 

 
Label with default boundary condition and 
zero source 

Creating a New Label 
To create a new label: 

1. In the Insert menu, click Block Label or Edge Label or Node Label, or go to 
correspondent group of labels in the tree and click New Label in the context (right 
mouse button) menu. 

2. New label will appear in the list prompting you to give it the name you want. 

3. Just type the label�s name you wish and press ENTER. 

After you define the data, new label appears in the list of existing labels. If data 
editing was canceled, new label is not created. 

Editing Label Data 
To edit the data associated with some label, double-click the label in the list, or select 
the label and click Properties in the Edit menu or the context menu. The dialog box 
appears; its view depends on the class of current problem and on the type of 
geometrical object that the label corresponds to. 
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To finish label data editing, click OK button. Clicking Cancel button will end the 
editing and discards all changes to the values. 

Editing Data in Magnetostatics 

 

With problems of magnetostatics, block label data contain two components of 
magnetic permeability tensor, the current density, and for permanent magnets also 
magnitude and direction of coercive force. 

With nonlinear materials, you need to define the magnetization curve, instead of 
magnetic permeability. In this case check the Nonlinear box to get into the B-H curve 
editor. If a B-H curve had already been defined, the dialog box would contain a 
B-H Curve button that can be chosen to get into the curve editor. Editing the 
magnetization curve is discussed in “Editing the Curves” section later in this chapter. 

When creating data for a new label, the text boxes for magnetic permeability 
components contain None instead of numbers. The word None in these boxes or the 
absence of the value means that the block with the corresponding label is excluded. If 
you want to define the material properties (and therefore include the block into 
consideration), simply type in a value of magnetic permeability, which will replace 
the highlighted None. 



36 Chapter 5  Problem Parameters Description 

If you need to define two components different from each other, first check the 
Anisotropic box. 

You can specify the kind of source (current densisty or total number of ampere-turns). 
If you have specified the total current, several blocks labeled with the same label can 
be considered as a single one or as conductors connected in series. Serial conductors 
are carring the same current and calculated current density could be different if their 
squares are not equal. 

With axisymmetrical problems, if the total number of ampere-turns is specified you 
can define that current density in your coil varies inversely to the radius rather than 
being distributed uniformly. It might be closer to reality if your block represents a 
massive spiral coil. 

 

The data for the edge label allow to assign one of possible boundary conditions. 
Select the type of condition and then type in the values. 
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The vertex in the problem of magnetostatics may have known potential or the 
concentrated current may flow through the vertex. Check one of the options and then 
enter a value. 

Editing Data in Time-Harmonic Magnetics 

 

With problems of time-harmonic magnetics, block label data contain two components 
of magnetic permeability tensor, electric conductivity and one of three possible field 
sources: source current density, voltage, or total current. 

When creating data for a new label, the text boxes for magnetic permeability 
components contain None instead of numbers. The word None in these boxes or the 
absence of the value means that the block with the corresponding label is excluded. If 
you want to define material properties (and therefore include the block into 
consideration), simply type in a value of magnetic permeability, which will replace 
the highlighted None. 

If you need to define the two components different from each other, first check the 
Anisotropic box. 

The method of applying sources is different for conductors and non-conductive areas. 
In first case, you may switch between voltage and total current, as in second case 
voltage is inappropriate, and you can apply current density or total current only. 
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When total current or voltage is specified you can define several block labeled with 
this label (if any) as a single one or as different conductors connected in series. In the 
last case the total current over each conductor will be the same and distribution of the 
current density is subject to solve. 

Note. It is assumed that the total current specified for a block label is the gross current 
in all blocks associated with that label. 

With time-harmonic problems, you always specify amplitude, or peak, values for all 
alternating quantities. 

 

The data for the edge label allow to assign one of possible boundary conditions. 
Select the type of condition and then type in the values. 
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The vertex in the problem of time-harmonic magnetics may have known potential or a 
concentrated current may flow through the vertex. Check one of the options and then 
enter a value. 

Editing Data in Electrostatics 

 

Block label data for electrostatics problem contain two components of electric 
permittivity and possibly distributed charge density. 

When creating data for a new label, the text boxes for electric permittivity 
components contain None instead of numbers. The word None in these boxes or the 
absence of the value means that the block with the corresponding label is excluded. If 
you want to define the material properties (and therefore include the block into 
consideration), simply type in a value of electric permittivity, which will replace the 
highlighted None. 

If you need to define two components different from each other, first check the 
Anisotropic box. 



40 Chapter 5  Problem Parameters Description 

 

The data for the edge label allow to assign one of the possible boundary conditions. 
Select a type of condition and then type in the values. 

 

The vertex in the problem of electrostatics may have known potential or concentrated 
charge. Check one of these options and then enter a value. 

Editing Data with Current Flow Problems 
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Block label data for the problem of current flow contain two components of electric 
resistivity. 

When creating data for a new label, the text boxes for electric resistivity components 
contain None instead of numbers. The word None in these boxes or the absence of the 
value means that the block with the corresponding label is excluded. If you want to 
define material properties (and therefore include the block into consideration), simply 
type in a value of electric resistivity, which will replace the highlighted None. 

If you need to define two different components of resistivity, first check the 
Anisotropic box. 

 

The data for the edge label allow you to assign one of possible boundary conditions. 
Select the type of condition and then type in the values. 

 

The vertex in the problem of current flow may have known potential or external 
current. Check one of these options and then enter a value. 
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Editing Data with Heat Transfer Problems 

 

The data for block label contain two components of thermal conductivity tensor and, 
possibly, the volume power of heat source. For transient analysis, the values of 
specific heat and volume density are also required. 

To describe the thermal conductivity as a function of temperature, check the 
Nonlinear box and the temperature curve editor for defining λλλλ = λλλλ(T) will be 
displayed. Curve editing is discussed in “Editing the Curves” section later in this 
chapter. 

Also the volume power of heat source could be described as a function of 
temperature. To do so, check the Function of Temperature box related to the heat 
source field. Editing the dependencies is described in “Editing the Curves”. 

Specific heat C can be specified as either the constant value or as a function of 
temperature. In latter case, check the Nonlinear box to bring up the Curve Editor for 
specific heat. 

When creating new label, the text boxes for thermal conductivity components contain 
None instead of numbers. The word None in these boxes or the absence of the value 
means that the block with the corresponding label is excluded. If you want to define 
material properties (and therefore include the block into consideration), simply type in 
a value of thermal conductivity, which will replace the highlighted None. 
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If you need to define two different components of thermal conductivity, first check 
the Anisotropic box. 

 

The data for edge label allow you to describe boundary conditions. Check the 
condition that you need, and then type in the parameters. The heat flux, convection, 
and radiation can be combined together, which means that the heat flow through the 
surface is compounded from several components. 

 

The vertex in heat transfer problem may have known temperature, or represent a line 
heat source. Check one of these options, and then enter the numeric parameter. 
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Editing Data with Stress Analysis Problems 
The data for the block label with stress analysis problem are spread between three 
tabs in a dialog box. 
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When creating new label, the text boxes for Young's moduli contain None instead of 
numbers. The word None in these boxes or the absence of the value means that the 
block with the corresponding label is excluded. If you want to define material 
properties (and therefore include the block into consideration), simply type in a value 
of the Young's modulus, which will replace the highlighted None. 

The Anisotropic boxes, which apply to elastic moduli and coefficients of thermal 
expansion, allow you to describe anisotropic properties in each set independently. 

The data for thermal loading are defined slightly different way for thermo-structural 
coupled and non coupled problems: 

• With an uncoupled problem, you define the temperature difference between 
strained and strainless states, which is assumed to be constant within all blocks 
with the corresponding label. 

• With thermo-structural coupling, you need to define a reference temperature of 
strain free state for each block subjected to thermal loading. 

The values of allowable stresses do not affect the solution. Those are only used in 
postprocessing stage to calculate the Mohr-Coulomb, Drucker-Prager, and Hill 
criteria. You don't need to define allowable stresses, if these criteria are of no interest 
to you. 
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The data defined for an edge label may include constraints along one or both 
coordinate axes and the surface forces are described either as normal pressure or by 
their Cartesian or polar coordinate system components. To apply fixed displacement 
along an axis, check the appropriate box and then enter a value of displacement. 
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The vertex label data may define rigid or elastic support along one or both coordinate 
axes, or concentrated external force. To describe rigid constraint along some axis, 
check the appropriate box, and then enter the value of fixed displacement. 

Editing the Curves 
Curve functions, which describe some field dependent parameters, are implemented 
as tables containing two columns: an argument and a function, e.g., magnetic field 
intensity and flux density or temperature and thermal conductivity. Editing the table is 
supported with graphical presentation of the dependency, which is interpolated with 
cubic spline between the entered points. The solver uses just the same curve as you 
see on your screen. 

 

To add the new point to the dependency, type in two values (B and H in shown 
example) and press ENTER key or choose Add button. If the argument of a new point 
coincides with the argument of existing one, new point replaces the old one. 

To remove the point, select it in the table and choose Delete button or press the DEL 
key. 

You may control the scaling of the graph with use of Zoom In or Zoom Out buttons, 
or simply by clicking and dragging diagonally in the graph. 
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To exit from editing the curve, choose Close button or press ESC. Note that 
subsequent canceling of label data editing with ESC key or the Cancel button will 
discard all changes including the curve editing. 

Copying, Renaming and Deleting Labels 
Labels can be copied within single property description document or between 
documents of the same type. 

To copy the label: 

1. In the list, select the label you want to copy with right mouse button and click 
Copy in the context menu. 

2. Switch to destination window and click Paste in the Edit menu or context menu. 

Or, 

1. Drag the label to destination position with the mouse. 

To delete the label: 

• In the list, select the label with right mouse button and click Delete in the context 
menu. 

• Or, select the label and click Delete in the Edit menu. 

To move (cut and paste) the label: 

1. In the list, select the label you want to move with right mouse button and click 
Cut in the context menu. 

2. Switch to destination window and click Paste in the Edit menu or context menu. 

Or, 

1. Drag the label to destination position with the mouse holding down the SHIFT 
key. 
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C H A P T E R  6  

Solving the Problem 

This chapter describes how to solve the prepared problem, and methods QuickField 
uses to solve. 

Several conditions have to be met to solve a problem. The problem type, plane, 
required precision and other parameters have to be specified in the problem 
description file. The model geometry file must contain complete model with mesh 
and labels. Each label referred by the model file is to be defined in the problem's 
private or library data file. 

To obtain the problem solution, click Solve Problem in the Edit menu or context 
(right mouse button) menu of the Problem editor. You may skip this action and 
directly proceed to the analysis results by clicking Analyze Results in the Edit or 
context menu. If the problem has not been solved yet, or its results are out of date, the 
solver will be invoked automatically. 

Each solver runs in its separate thread, so you can solve several problems at once or 
edit or analyze other problems while the problem is being solved. There is of course 
no sence in editing any document related to the problem being solved. 

Special bar indicator lets you see the progress of the solution process. Linear 
problems are solved by using a powerful preconditioned conjugate gradient method. 
The preconditioning based on the geometric decomposition technique guaranties a 
very high speed and close to linear dependence between number of nodes and the 
resulting solution time. Nonlinear problems are solved using the Newton-Raphson 
method. The Jacobian matrix arising at each step of the Newton-Raphson method is 
inverted the same way as it is done for linear problems. 

We use the Euler�s method (constant time step size) for solving transient problems, 
with initial value set to zero or taken from another temperature field calculation. This 
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method is extremely fast and stable, however we recommend having at least 15-20 
time steps for whole transitional process to achieve accurate and smooth results. 

Achieving Maximum Performance 
The algorithm used in QuickField solver does not require the whole data of the 
problem to fit into memory of your computer. The solver can effectively handle linear 
algebraic systems with matrices several times bigger than the amount of available 
physical memory. Data that don�t fit into memory are stored on the hard disk. The 
size of the problem you can solve on your computer is only limited by the amount of 
free disk space. Memory consumption is very low compared to other FEA packages, 
only about 1.3 MB per ten thousand degrees of freedom. 

Although size of the problem is not limited by the amount of available memory, 
having additional memory may improve performance. It is obvious that the 
performance is the best when all the data can be stored in memory and relatively slow 
disk access is not used during solution. 

However, to solve very large problems on a computer with insufficient memory it is 
essential that virtual memory is configured optimally. 

To manage virtual memory settings: 

1. Bring up Control Panel and double-click System. 

2. Switch to Performance tab. 

3. See Windows Help for details. 
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C H A P T E R  7  

Analyzing Solution 

This chapter explains the procedures for detailed examination of the results using the 
QuickField postprocessing utility. 

To analyze the problem solution, choose View Results in the Edit menu or context 
menu of the problem window. The Postprocessor provides various ways of results� 
presentation: 

• field pictures, 
• local field values, 
• integral quantities, 
• X-Y plots, 
• tables. 
• tables and plots vs. time for transient problems. 

Any picture or numerical value displayed by the postprocessor can be copied to 
Windows clipboard for use with any word-processing or desktop publishing utility or 
subsequent use by spreadsheet or user-written programs. 

Building the Field Picture on the Screen 
Interpreted Quantities 
The set of the physical quantities, which can be displayed by the Postprocessor, 
depends on the problem type. 

For the electrostatic problem these quantities are: 
• Scalar electric potential (voltage) U; 
• Vector of electric field intensity E ==== −−−− gradU; 
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• Tensor of gradient of electric field  G ==== gradE; 
• Vector of electrostatic induction D ==== εE; 
• Electric permittivity ε (or its largest component in anisotropic media); 
• Electrostatic field energy density ( )w = ⋅E D 2 . 

For the magnetostatic problem: 
• Vector magnetic potential A in plane-parallel problem or flux function Φ = 2πrA 

in axisymmetric case; 
• Vector of magnetic flux density B = curl A; 
• Vector of magnetic field intensity H = µ−1⋅B; 
• Magnetic permeability µ (its largest component in anisotropic media); 
• Magnetic field energy density: 

( )w = ⋅B H 2   �in linear media, 

( )w = ⋅∫ H dB  �in ferromagnetic media. 

For the time-harmonic electromagnetic problem: 
• Complex amplitude of vector magnetic potential A (flux function rA in 

axisymmetric case); 
• Complex amplitude of voltage U applied to the conductor; 
• Complex amplitude of total current density j = j0 + jeddy, source current density j0 

and eddy current density jeddy  = −iωgA. 

All these complex quantities may be shown in form of momentary, root mean 
square (RMS) or peak value in time dimension. 

E.g., complex quantity ( )z z ei t z= +
0

ω φ my be shown as: 

• momentary value at a given phase  φ0 = ωt0 
( )[ ] ( )z z e zi

z
z

φ
φ φ φ φ

0

0

0 0 0= = ++Re cos ; 

• peak value z0; 
• RMS value 

z zRMS = 2
2 0 . 

• Complex vector of the magnetic flux density B = curl A 

B
A
y

B
A
xx y= = −

∂
∂

∂
∂

,  �for planar case; 
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( )
B

r
rA
r

B
A
zz r= = −

1 ∂
∂

∂
∂

,  �for axisymmetric case; 

• Complex vector of magnetic field intensity H = µ-1B, where µ is the magnetic 
permeability tensor. 

Complex vectors may be shown in form of momentary, RMS or peak magnitude. 

• Time average and peak Joule heat density Q = g-1 j2; 
• Time average and peak magnetic field energy density ( )w = ⋅B H 2 ; 
• Time average Poynting vector (local power flow) S E H= × ; 
• Time average Lorentz force density vector F j B= × ; 
• Magnetic permeability µ (its largest component in anisotropic media); 
• Electric conductivity g. 

For the problem of current flow: 
• Scalar electric potential U; 
• Vector of electric field intensity E ==== −−−− gradU; 
• Vector of current density j = ρ−1⋅E; 
• Electric resistivity ρ (its largest component in anisotropic media); 
• Ohmic losses per volume unit ( )w = ⋅j E 2 . 

For heat transfer problem: 
• Temperature T; 
• Vector of heat flow F = −−−−λ⋅grad(T); 
• Thermal conductivity λ (its largest component in anisotropic media). 

For stress analysis problem: 
• Displacement vector δ; 
• Strain tensor ε and its principal values; 
• Stress tensor σ and its principal values; 
• Von Mises stress (stored energy of deformation criterion): 

( ) ( ) ( )[ ]σ σ σ σ σ σ σe = − + − + −
1
2 1 2

2
2 3

2
3 1

2 ; 

where σ1, σ2 and σ3 denote the principal stresses in descending order. 

• Tresca criterion (maximum shear): 

σ σ σe = −1 3 ; 
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• Mohr-Coulomb criterion: 

σ σ χσe = −1 3 , 

where 

[ ]
[ ]

χ
σ
σ

= +

−

, 

[ ]σ+  and [ ]σ−  denote tensile and compressive allowable stress. 

• Drucker-Prager criterion: 

( ) [ ]
σ χ σ

χ χ
χ

σ
σ

χ
χ

σe i= + −
−

+
+

−
+











−

1
1

1 1
1

2

, 

where 

( ) ( ) ( )[ ]σ σ σ σ σ σ σi = − + − + −
1
2 1 2

2
2 3

2
3 1

2 ; 

σ
σ σ σ

=
+ +1 2 3

3
. 

• Hill failure index for orthotropic materials: 

F.I .= − + +
σ σ σ σ τ1

2

1
2

1 2

1
2

2
2

2
2

12
2

12
2X X X S

, 

where σ1, σ2 and τ12 are computed stresses in the material directions and, 

X X X XT C
1 1 1 10 0= > = <  if if1 1σ σ;  

X X X XT C
2 2 2 20 0= > = <if if2 2σ σ;  

S S S S12 12 12 120 0= > = <+ −if if12 12τ τ;  

The Hill failure index is calculated only for those materials, where allowable 
stresses were defined (while editing the block data, see “Problem Parameters 
Description”). If any pair of allowable stresses is not given, the corresponding 
term is dropped while calculating the Hill Index. 



  Building the Field Picture on the Screen 57 

Field Presentation Methods 
Several methods are available for displaying the field picture: 

 

Color map for distribution of a chosen 
scalar quantity. The color map is 
accompanied by the legend showing 
the correspondence between colors 
and numerical values. 

You can adjust the color scale by 
changing the range limits for the 
chosen quantity. 
Color map may be shown in gray 
scale mode if you want to optimize it 
for monochrome printing. 

 

Field lines. Those are isotherms for 
temperature fields, lines of equal 
potential in electrostatics and flux 
lines for magnetostatic problems. 

You can manipulate the picture by 
changing the distance between 
neighboring lines. This distance is 
measured in units of chosen quantity. 

 

Vectors�family of line segments 
showing magnitude and direction of 
the vector quantity. Vectors are drawn 
in the nodes of the regular rectangular 
grid. 

You can change the grid cell size and 
the scaling factor for a desired vector 
quantity. 
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The following methods are specifically for stress analysis problems: 

 

Deformed boundary and shape 
indicated by means of deformed and 
original rectangular grid. 

Stress tensor display as a pair of 
eigenvectors reflecting the direction 
of principal axes, magnitudes and 
signs of principal stresses (blue color 
denotes tension, red color—
compression); 

With these methods, you can change the grid cell size and the scaling factors in order 
to manipulate the appearance. 

It is possible to combine several visualization methods in the same picture to obtain 
the most expressive result. 

QuickField can display several different field pictures for the same problem. To open 
a new window, click New Window in the Window menu. 

Field Picture Constructing 
When entering the Postprocessor, the default form of the field picture appears on the 
screen. You may use Field Picture in the View menu or context menu to select other 
display methods or quantities. 
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Shown dialog box corresponds to the problem of magnetics. 

To choose desired visualization method, select corresponding check box. You can 
select any combination of methods at once. If none of the methods is selected, only 
the model's geometry is shown. 

This dialog box also allows changing scaling parameters for selected methods of 
presentation and the number of color grades used with the color map. When you 
select some edit box, you can choose Suggest button to obtain suggested value of 
corresponding parameter. Note that suggested values for Minimum and Maximum 
fields are calculated for the currently visible part of the model. 

In case of time-harmonic electromagnetic problem, equilines and vectors are drawn at 
specified phase. The Field View dialog box allows setting phase value. For more 
expressive field picture, you can order the second family of equilines or vectors, 
shifted with regard to the first by 90°. 
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The Field View dialog box for the stress analysis problem additionally allows to 
select tensor quantity visualization. 
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Sizes of the vector symbols for all vector quantities except the displacement vector 
are determined by the corresponding physical value multiplied by the scaling factor 
and by the cell size. Similar method is used for stress tensor components. Unlike other 
vector quantities, the size of the displacement vector on the screen does not depend on 
the cell size. It is determined by the dimensionless scaling factor, the unit value of 
which means that the displacement is shown in its natural scale. 

Color map of temperature difference in stress analysis problem visualizes temperature 
distribution as it is defined by user or imported from linked heat transfer problem. In 
the last case, temperature is shown only in those blocks, where it is really taken into 
account. 

The Failure Index option is available when the model contains at least one block 
with correctly defined allowable stresses. 

Choosing the OK button causes redrawing the field picture on the screen. Cancel 
closes the dialog box without redrawing the picture and preserves preceding values of 
all the parameters. 

Zooming 
Zooming in postprocessor view is very similar to the analogous option of the Model 
Editor. 

To magnify the picture: 

1. Click Zoom In button in the toolbar 

2. Select the rectangle (click and drag diagonally), which then will occupy the whole 
window. 

To see more of the model: 

• Click Zoom Out button in the toolbar. 
• Or, click Zoom to Fit to see the whole model. 

Selecting a Time Layer 
With a transient problem a field picture displayed corresponds to the specific time 
moment. A Time combo-box in the postprocessor toolbar displays the currently 
selected time layer and allows you to change it. Initially the very first time layer is 
displayed.  
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The field pictures, XY-Plots and tables redraw automatically when you change the 
time value, but the scaling factors set for several displaying methods do not change. 

Calculator Window 
Calculator Window is a window normally docked to the left side of the field view.  

To open the calculator window, choose Calculator Window command in the View 
menu or corresponded button on the postprocessor toolbar. The calculator window 
also opens when choosing Local Values, Integral Values or one of the Wizard 
commands in View menu. 

The calculator window is organized in several trees which root items correspond to 
several kinds of numerical data. These are: 

• Local Values shows several field quantities at a point of interest; 
• Integral calculator lists available quantities calculated by integration over given 

line, surface or volume; 
• Inductance Wizard opens wizard, which helps you calculate self or mutual 

inductance of the coils and conductors, 
• Capacitance Wizard opens wizard guiding you through steps needed to calculate 

self or mutual capacitance of your conductors in electrostatics problems, 
• Impedance Wizard opens wizard, which helps you calculate the impedance of 

the conductors in AC magnetics problems. 

To open the set of values, double-click the corresponding item, or select it and press 
ENTER. 

The calculator window is initially docked to the left side of the field view. To change 
its width, point to the gray splitter strip between windows and drag it to the left or to 
the right. You can dock the window to the right side of the field view or make it 
floating as ordinary popup window. Point at the window caption and drag it to the 
desired position. 

You can select one or several items in the tree and copy them to the clipboard or drag 
to any application that supports drag-and-drop copy/paste operation (almost any word 
processor or spreadsheet). To select more than one item, click on it holding the SHIFT 
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key (block selection) or the CTRL key (random selection). Context (right mouse 
button) menu also works in the calculator window. It provides you with the subset of 
commands for manipulating the field picture in the active view. 

With a transient problem all the values in the calculator window correspond to the 
chosen time layer. See Selecting a Time Layer�Selecting a Time Layer� section above 
for more details. 

Examining Local Field Data 
To obtain local field data, click Local Values in the View menu or context (right 
mouse button) menu in field picture window. Otherwise if the calculator window is 
already open, double-click the Local Values item in the tree. The message appears 
prompting you to click the point. Then you can click points where you need to know 
the values of the field quantities. 

To enter coordinates of the point of interest from keyboard, select any of coordinates 
with mouse and then click it again (after a period, to avoid the double-click effect) or 
choose Edit Point command from context menu. You can edit either Cartesian or 
polar coordinates. 

To leave this mode, close local values window, or choose Local Values in the menu 
again or click corresponding button on the toolbar. 

The local values of physical quantities obtained in the Local Values mode can be 
copied to clipboard for printing numerical results, or to pass them to other application 
program, e.g., a spreadsheet program to produce a report. Click the Copy button in 
the Local Values window. To see or copy exactly those field quantities you need, you 
can expand or collapse branches in the tree. 

Parameter Calculation Wizards 
The most common design parameters in QuickField are calculated through wizards. 
These calculations still could be done by using the ordinary integral quantities 
available in the postprocessor, but wizards allow you to get the results quicker and in 
most cases you can avoid manual building of the contour of integration and 
manipulating with complex values. 

These three wizards are available in QuickField: 
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• Inductance Wizard calculates self or mutual inductance of the coil or conductor in 
AC or DC magnetics problems, 

• Capacitance Wizard calculates self or mutual capacitance of the conductors in 
electrostatics problems, 

• Impedance Wizard calculates impedance of the conductor in AC magnetics 
problems. 

To start the wizard, choose Wizard in View menu, or double-click the corresponding 
item in the calculator window. If the calculator window is open while you start the 
wizard, all the parameters calculated by the wizard are shown in that view. You can 
start wizard again from not only its start page but also from any other page by double-
clicking the corresponding value in the Values tree. 

Some of the wizards provide several alternative ways to calculate the desired 
quantity. Each way is represented in the calculator window as a separate tree. 

Inductance Wizard 
Inductance wizard helps you to calculate self and mutual inductance of your coils in 
the problem of magnetostatics or time-harmonic magnetics. 

When your model contains several coils that carry different currents, the flux linkage 
with one of them can be calculated as 

∑+=
n

nnkkkkk iMiLφ , 

where kkL  is the self inductance of the coil k, nkM is the mutual inductance between 
the coils n and k, ki  is the current in the coil k. 

On the other hand, stored magnetic energy also derives from current and inductance: 








 += ∑∑
≠kn

knnk
k

kkk iiMiLW 2

2
1

 

Before using the inductance wizard, you have to formulate your problem in such a 
way that all the currents (space, surface or linearly distributed) but one are set to zero. 
There must be no permanent magnets in your model. In that case equation above 
becomes extremely simple and you can get inductance value as: 
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i
L φ= , 

where φ  is the flux linkage with the coil excited by current i, or 

22
i
WL ⋅= , 

where W is stored magnetic energy and i is the only current. 

The first approach gives the self-inductance, if you get the flux linkage and the 
current in the same coil and mutual inductance if the coils are different. The second 
approach gives only the self-inductance. 

Initial page of the inductance wizards invites you to choose between two approaches 
described above. After choosing one of them click the Next button. 

The second page of inductance wizard allows you to define, which blocks represent 
the cross section of your coil. In general, two blocks represent each coil in the model 
plane: forward and return wires. If there is only one side of the coil in your model, the 
second one is assumed as being symmetrical to the first one or as being infinitely 
distant of the model and not affecting the field distribution. 
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To define each side of your coil, simply point the corresponding item in the Block 
Labels list and drag it to one of the side list. You can also use the Add buttons. No 
matter, which side of your coil you call Right Side and which Left Side. If only one 
side of the coil is represented in the model, drag item Symmetry to the opposite list if 
return wire of the coil is symmetrical to the direct one, or leave the list empty if return 
wire does not affect the electromagnetic state of your model. 

You can select and drag more than one item at once if the cross section of your coil is 
split to several blocks. 

Enter the Number of Turns for your coil if it is more than one. 

As result of any action on the lists or number of turns the Flux Linkage value will 
change automatically being calculated as 
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where A is the vector magnetic potential; R and L denote the right and the left side of 
the coil accordingly,  r is the radius of the point. 

For planar problems flux linkage and the inductance are calculated per one meter of 
axial depth no matter what length unit you have chosen. 

When you finish with flux linkage calculation, click on the Next button. In the 
Current page you can select the current exciting the field and provide a number of 
turns in your coil. 
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Capacitance Wizard 
Capacitance wizard helps you to calculate self and mutual capacitance of your 
conductors. 

When your model contains several conductors, the charge of one of them can be 
calculated as: 
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where kkC  is the self capacitance of the conductor k, nkC  is the mutual capacitance 
between the conductors n and k, kU  is the voltage drop on the conductor k. 

On the other hand stored energy also derives from charge and capacitance as: 
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and from the voltage and capacitance as: 
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Before using the capacitance wizard, you have to formulate your problem in such a 
way that all field sources (space, surface or linear distributed charge or voltage) but 
one are set to zero. In that case equation above becomes extremely simple and you 
can get capacitance value if you know any two of these three quantities: charge, 
voltage, stored energy 

When formulating your problem, you can apply known voltage to the conductor and 
measure the charge it produce or vice versa. Measuring the charge is a bit more 
complex than the voltage. It requires you to build the closed contour surrounding your 
conductor (but not coinciding with its surface) before you start the capacitance 
wizard. The easiest way to formulate the problem for capacitance calculating is to put 
constant potential boundary condition on the conductor�s surface and specify an 
arbitrary non zero electric charge in one of the vertices on the surface of the 
conductor. 

This page of capacitance wizard allows you to specify electrodes which capacitance 
you want to calculate. Electrodes listed on the right side of the page are organized in 
two subtrees: surface conductors and linear conductors (if any). 

In case you are calculating the capacitance of the condenser consisting of two 
electrodes, select both of them. When choosing more than one electrode their voltage 
will be sum up (with their sign). 
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In the right side of the page electrodes are listed which charge you have specified. If 
you have put voltage boundary condition rather then charge on your electrodes, the 
only way to calculate the charge is to build the contour surrounding it but not 
coincident with it boundary. If so, you have to do that before you start the capacitance 
wizard. 

When selecting one or more items in the list, you get the resulting charge in the 
Charge box. 

Impedance Wizard 
Impedance wizard helps you to calculate the impedance of your conductors. It is 
simple and contains only one page. To get the impedance value and its real and 
imaginary parts (resistance and reactance accordingly) the impedance wizard simply 
divides complex values of voltage by current: 

I
UZ =  

);(),( ZimXZreR L ==  

,
2 f
XL L

π
=  

where Z is absolute value of the impedance and  f is the frequency. 
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If you select more than one conductor at once, the impedance wizard considers it as 
being connected in parallel if the voltage applied to each of them is equal and as being 
connected in series otherwise. 

Editing Contours 
The contour is a directed curved line consisting of line segments and arcs (including 
the edges of the model). Some rules are applied to the contours: 

• The contour may not intersect itself. 
• Open and closed contours are discerned. 
• Multiply connected contours have sense only for calculating integral quantities. 

Contour is shown in the field picture window as a set of directed lines or color-filled 
interior (closed counter-clockwise-directed contours). 

QuickField allows editing contours in field picture windows. The following 
operations change the current contour state: 

Adding lines  attaches a line segment or an arc to the contour. The arc is 
specified by its degree measure (zero means line segment) 
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and two end points. Any arbitrary line may initiate the 
contour, but only adjacent lines are accepted later. The line 
cannot be added to the closed contour. There are two ways 
to add lines to contour: choose Pick Elements from 
Contour menu or context menu and then drag mouse with 
left button pressed. Or, choose Add Lines from Contour 
menu or context menu and enter end points coordinates 
from keyboard. 

Adding edges  appends the contour with an edge of the model. The 
contour may be initiated by any arbitrary edge, but only 
adjacent edges are accepted later. The edge cannot be 
added to the closed contour, or if the ending point of the 
contour does not currently coincide with model�s vertex. 
To add edges, choose Pick Elements from Contour menu 
or context menu and then pick series of adjacent edges 
with mouse. 

Adding blocks  considers the current closed contour as a border of the 
plane region and updates that region by adding (or 
subtracting) a block of the model in the sense of set theory. 
To add blocks, choose Pick Elements from Contour 
menu or context menu and then pick blocks with mouse. 

Close contour  closes an open contour by connecting its open ends with a 
straight line or an arc, depending on current degree 
measure in the postprocessing toolbar. 

Change direction  alters the contour direction. 

Clear  deletes the entire contour. 

Delete last  deletes the last element (line or edge) in the contour. Not 
applicable to multiply connected contours. 

Depending on current state of the contour, some editing operations may be prohibited. 

The direction of the contour is significant in the following cases: 

• For volume integrals, the domain of integration lies to the left of the contour. 
• For surface integrals, the positive normal vector points to the right relative to the 

contour direction. 
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• The starting point of the contour corresponds to zero point at the x-axis of the X-Y 
plot. 

• If the plotted or the integrated function has different values to the left and to the 
right of the contour, the right-hand value is used. 

X-Y Plots 
QuickField postprocessor can display field distribution along contours. To open new 
X-Y plot window, choose X-Y plot in View menu or context (right mouse button) 
menu in field picture window, in which the contour is already defined. 

In X-Y plot view, you can: 

• Select the set of shown quantities. Click X-Y Plot Curves in the View or context 
menu. 

• Zoom the plot in or out. 
• View the correspondence between quantities and curves (legend). 
• Copy the picture to clipboard. 
• Open new X-Y plot window for the same contour. 

X-Y Plot Control 

 

Few quantities having the same unit of measurement can be shown at the same X-Y 
plot. According to this, all quantities are combined into groups. Full list of quantities 
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includes all those available for the color map representation (see “Interpreted 
Quantities”), and also normal and tangential components of vector and scalar 
quantities. 

When you select the appropriate group of quantities, the Curves to Show list contains 
the quantities selected for display, and the Available Quantities list contains 
available but not selected quantities. You can use buttons located between the lists, or 
simply double-click in the lists, to move some quantity from one list to another. 

In the dialog box, you can also modify the range of y coordinate. By default, it fits all 
the currently selected curves. You can get the suggested value of lower or upper limit 
by selecting the corresponding text box (Minimum or Maximum) and choosing 
Suggest button. 

In time-harmonic analysis, you can also switch between momentary (at given phase), 
time average and peak values of time dependent quantities. 

You can turn on or off the switches for displaying coordinate grid and markers on the 
curves. The last mode allows you to distinguish between the coinciding curves. 

Calculating Integrals 
QuickField calculates line, surface and volume integrals. In plane-parallel problem, a 
contour defines cylindrical (in generalized sense) surface of infinite depth, or volume 
of that cylinder for volume integral. Therefore, in plane-parallel formulation surface 
and volume integrals are calculated per unit depth. In axisymmetric problem, a 
contour defines toroidal surface, or toroid for volume integral. 

Positive direction of a contour is counter-clockwise. The direction of the contour is 
accounted as follows: 

• For volume integrals the domain of integration lies to the left of the contour. 
• For surface integrals the positive normal vector points to the right relative to the 

contour direction. 
• If the plotted or the integrated function has different values to the left and to the 

right of the contour, the right-hand value is used. 

Force, torque and electric charge integrals represent real physical quantities only 
when the contour is closed. However, these integrals are calculated for the unclosed 
contours too. 



  Calculating Integrals 75 

To calculate integrals, click Integral Values in the View menu or context (right 
mouse button) menu. Or, if calculator window is already open, double-click on the 
Integral Calculator item in the tree. If the contour is already defined, a list of 
available integral quantities appears. The list varies depends on whether your contour 
is open or closed. If you have no contour defined in the active field view, a message 
appears prompting you to build the contour. You can get a value of an integral 
parameter by click on the small gray button left on its name or by double click on the 
name. Once opened the integral value will be recalculated automatically each time 
you change the contour. 

Some integrals require closed counter-clockwise oriented contour, otherwise they 
have no physical sense. Once you created the contour, you can select an integral 
quantity from the list and choose Calculate button to get the value. Copy button 
allows you to copy the calculated result to clipboard. 

When the electrostatic or magnetic force, torque, electric charge, electric current or 
heat flux are to be calculated, the domain of integration may be chosen by many 
different ways. The only requirement for the surface of integration is to contain all the 
necessary bodies, but to avoid any extra bodies or field sources. It is important to 
understand that the accuracy will be the best if you choose the integration surface as 
far as possible from the places with strong inhomogeneity of field, e.g., field sources 
or boundaries of conducting or ferromagnetic bodies. 

When calculating the flux linkage the domain of integration must exactly fit the cross 
section of the coil. 

The quantities available for electrostatic problems: 
• Total electric charge in a particular volume 

q ds= ⋅∫D n , 

where integral is evaluated over the boundary of the volume, and n denotes the 
vector of the outward unit normal. 

• Total electrostatic force acting on bodies contained in a particular volume 

( ) ( ) ( )( )F E n D D n E n E D= ⋅ + ⋅ − ⋅∫
1
2

ds  

• Total torque of electrostatic forces acting on bodies contained in a particular 
volume 

( )( ) ( )( ) ( )( )( )T r E n D r D n E r n E D= × ⋅ + × ⋅ − × ⋅∫
1
2

ds  
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where r is a radius vector of the point of integration. 

The torque vector is parallel to z-axis in planar case, and is identically equal to 
zero in axisymmetric one. The torque is considered relative to the origin of the 
coordinate system. The torque relative to any other arbitrary point can be obtained 
by adding extra term of F × r0, where F is the total force and r0 is the radius 
vector of the point. 

• Electric field energy 

( )W dV= ⋅∫
1
2

E D . 

For magnetostatic problems: 
• Total magnetostatic force acting on bodies contained in a particular volume 

( ) ( ) ( )( )F H n B B n H n H B= ⋅ + ⋅ − ⋅∫
1
2

ds , 

where integral is evaluated over the boundary of the volume, and n denotes the 
vector of the outward unit normal. 

• Total torque of magnetic forces acting on bodies contained in a particular volume 

( )( ) ( )( ) ( )( )( )T r H n B r B n H r n H B= × ⋅ + × ⋅ − × ⋅∫
1
2

ds , 

where r is a radius vector of the point of integration. 

The torque vector is parallel to z-axis in the planar case, and is identically equal to 
zero in the axisymmetric one. The torque is considered relative to the origin of the 
coordinate system. The torque relative to any other arbitrary point can be obtained 
by adding extra term of F × r0, where F is the total force and r0 is the radius vector 
of the point. 

• Magnetic field energy 

( )W dV= ⋅∫
1
2

H B  � linear case; 

( )W H B dB dV
B

= ′ ′








∫∫

0

 � nonlinear case. 

• Flux linkage per one turn of the coil 
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Ψ = ∫ Ads

S
 � for planar case; 

Ψ = ∫2π rAds

S
 � for axisymmetric case; 

the integral has to be evaluated over a cross section of the coil, and S is the area of 
the cross section. 

For time-harmonic electromagnetic problems: 
• Complex magnitude of electric current through a particular surface 

I jds= ∫  

and also its source and eddy components I0 and Ie. 

• Time average and peak Joule heat in a volume 

Q g j dV= −∫ 1 2 . 

• Time average and peak magnetic field energy 

( )W dV= ⋅∫
1
2

H B . 

• Time average and peak power flow through the given surface (Poynting vector 
flow) 

S ds= ⋅∫ ( )S n . 

• Time average and oscillating part of Maxwell force acting on bodies contained in 
a particular volume 

( ) ( ) ( )( )F H n B B n H n H B= ⋅ + ⋅ − ⋅∫
1
2

ds , 

where integral is evaluated over the boundary of the volume, and n denotes the 
vector of the outward unit normal. 

• Time average and peak Maxwell force torque acting on bodies contained in a 
particular volume 

( )( ) ( )( ) ( )( )( )T r H n B r B n H r n H B= × ⋅ + × ⋅ − × ⋅∫
1
2

ds , 
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where r is a radius vector of the point of integration. 

• Time average and oscillating part of Lorentz force acting on conductors contained 
in a particular volume 

F j B= ×∫ dV . 

• Time average and peak Lorentz force torque acting on bodies contained in a 
particular volume 

( )T r j B= × ×∫ dV , 

where r is a radius vector of the point of integration. 

The torque vector is parallel to z-axis in the planar case, and is identically equal to 
zero in the axisymmetric one. The torque is considered relative to the origin of the 
coordinate system. The torque relative to any other arbitrary point can be obtained 
by adding extra term of F × r0, where F is the total force and r0 is the radius 
vector of the point. 

Note. The Maxwell force incorporates both the force acting on ferromagnetic bodies 
and Lorentz force, which acts only on conductors. If the first component is negligible 
or is not considered, we recommend calculating the electromagnetic force as Lorentz 
force. Its precision is less sensitive to the contour path, and you can simply select 
conductors via block selection to calculate the force. With Maxwell force, this method 
leads to very rough results, and you are recommended to avoid coinciding of your 
contour parts and material boundaries, as described earlier in this chapter. 

For problems of current flow: 
• Electric current through a given surface 

I ds= ⋅∫ j n , 

where n denotes the vector of the unit normal. 

• Power losses in a volume 

W dV= ⋅∫ E j . 
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For heat transfer problems: 
• Heat flux through an arbitrary closed or unclosed surface 

Φ = ⋅∫ F nds , 

where n denotes the unit vector of normal to the surface. 

No integral quantities are available for stress analysis. 

Data Tables 
QuickField can display the field data at discrete points, distributed along the currently 
selected contour, in table view. To open new table window, choose Table in the View 
menu or context (right mouse button) menu in field picture window, in which the 
contour is already defined. 

In table view, you can: 

• Select the list of shown quantities (table columns). Choose Columns in View or 
context menu. 

• Select how the points are distributed along the contour (table rows). Choose Rows 
in View or context menu. 

• Insert additional rows at specified distance from the beginning of the contour. 
Choose Insert in Edit or context menu. 

• Copy the set of rows or the whole table to Windows clipboard. In latter case 
(when all of the rows are selected), column headers are also copied. To copy the 
header only, click the right mouse button within the header and choose Copy 
Header from the context menu. 

Plots and Tables versus Time 
Time Plot 
With a transient problem, the QuickField postprocessor can plot dependencies of 
various field quantities vs. time. To open a new time plot window, choose the 
Time Plot command 
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• . If you choose the Time Plot command in the View menu of field picture 
window, an empty time plot window opens and the Add Curves to Time Plot 
dialog appears. 

•  Alternatively right click in the field picture window - a curve for the point you 
clicked will automatically be added to the time plot. You can obtain the same 
result by choosing Time Plot command in calculator window�s context menu, 
where local values are displayed. 

Time plot window can display curves for several points. In its turn, each point can 
have several curves for different field quantities as long as these quantities belong to 
the same family: temperature, temperature gradient, or heat flux. You use the time 
plot control dialog to manipulate points and curves. 

Time Plot Control 
The Time Plot Curves command in the View menu or context menu in time plot 
brings the time plot curves dialog up. 

 

To add a new point, click the very first row in the table, then type coordinates in the 
boxes above and click the Add button. When choosing a point in the list you can 
change its coordinates and switch on and off associated curves. 

The drop-down list at the bottom allows you switch between the curve families. 
Alternatively you can choose the family in context (right mouse click) menu in time 
plot window. 
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Time Dependencies Table 
All the field quantities for a given point versus time can be displayed in a table. To 
open the table choose the Time Table command in View menu or context menu. 

 

Initially, the origin becomes a tabulated point. To choose another point, type 
Cartesian coordinates in the boxes above table and click the OK button. 

Controlling Legend Display 
The legend for the color map shows the correspondence between colors and number; 
and for X-Y plot�between curves and quantities. 

To switch the legend display on or off, click Legend in the View or context menu in 
field picture or X-Y plot window. 

Printing the Postprocessor Pictures 
You can directly print the field picture or X-Y plot to your local or network printer, 
just as you see the model in the window, with the same zooming and discretization 
visibility. 

• To print the picture, click Print in the File menu. You will have an option to 
choose the printer and set up the picture, such as paper size and orientation, before 
printing will occur. 

• To preview the output before printing, click Print Preview in the File menu. To 
see how the picture will appear on a printer of your choice, click Print Setup 
before. 

Copying the Postprocessor Pictures 
You can copy the field picture or X-Y plot, as you see it in the window, to clipboard, 
for subsequent including it to your paper or report in any word-processing or desktop 
publishing utility. 
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• To copy the picture, click Copy Picture in the Edit menu, or press CTRL+INS. 
• Switch to the application where you want to paste the picture and click Paste in 

the Edit menu, or press SHIFT+INS. 
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C H A P T E R  8  

Theoretical Description 

The objective of this chapter is to outline the theories on which the QuickField finite 
element analysis system is based. The chapter contains underlying mathematical 
equations, and considers various physical conditions and the ways how they are 
implemented in QuickField. 

QuickField solves 2D boundary value problems for elliptic partial differential 
equation for either scalar or one-component vector potential. It also solves 2D solid 
stress analysis problems (plane stress, plane strain, axisymmetric stress). There are 
three main classes of 2D problems: plane, plane-parallel and axisymmetric. Plane 
problems usually arise when describing heat transfer processes in thin plates. They 
are solved in planar rectangular coordinate system. Plane-parallel problems use 
right-handed Cartesian coordinate system xyz. It is assumed that neither geometric 
shape and properties of material nor field sources vary in z-direction. The problem is 
described, solved and the results are analyzed in xy-plane, which we will call the 
plane of model. Axisymmetric problems are formulated in cylindrical coordinate 
system zrθ. The order of axes is chosen for conformity with the plane-parallel case. 
Physical properties and field sources are assumed to not depend on the angle 
coordinate. All operations with the model are done in zr-plane (more precise in a half 
plane r ≥ 0). Z-axis is assumed to be horizontal and directed to the right, r-axis is 
directed up. 

The geometric configuration of the problem is defined as a set of curved polygonal 
subregions in the plane of model. Each region corresponds to a domain with a 
particular set of physical properties. We will use term blocks for polygonal 
subregions, term edges for line segments and circular arcs that constitute their 
boundaries and term vertices for ends of edges and for isolated points. Those edges 
that separate whole problem region from other part of the plane, where no field is 
calculated, constitutes the outward boundary of the region. Other edges constitute 
inner boundaries. 
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Below you can find detailed mathematical formulations for magnetic, electrostatic, 
current flow, heat transfer, and stress analysis problems. 

Magnetostatics 
QuickField can solve both linear and nonlinear magnetic problems. Magnetic field 
may be induced by the concentrated or distributed currents, permanent magnets or 
external magnetic fields. 

The magnetic problem is formulated as the Poisson's equation for vector magnetic 
potential A (B = curl A, B magnetic flux density vector). The flux density is 
assumed to lie in the plane of model (xy or zr), while the vector of electric current 
density j and the vector potential A are orthogonal to it. Only jz and Az in planar or jθ 
and Aθ in axisymmetric case are not equal to zero. We will denote them simply j and 
A. The equation for planar case is 

∂
∂ µ
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∂
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and for axisymmetric case is 
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where components of magnetic permeability tensor µx and µy (µz and µr), components 
of coercive force vector Hcx and Hcy (Hcz and Hcr), and current density j are constants 
within each block of the model. 

Note. Isotropic (µx = µy or µz = µr) but field dependent permeability is assumed in 
nonlinear case. Magnetization characteristic of material is described by the B-H curve. 

Field Sources 
The field sources can be specified in blocks, at the edges or at the individual vertices 
of the model. Possible field sources include space, surface and linear electric currents 
and permanent magnets. The coercive force is chosen to be primary characteristic for 
the permanent magnets. 
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A point source in the xy-plane describes a linear current in out-of-plane direction. In 
axisymmetric case the point source represents the current in a thin ring around the 
axis of symmetry. Edge-bound source in the plane of model represents a surface 
current in three-dimensional world. It is specified by the Neumann boundary 
condition for the edge. The space current is described either by the electric current 
density or total number of ampere-turns associated with the block  density associated 
with the block. Current density in a coil can be obtained from the equation 

j
n I
S

=
⋅

, 

where n is a number of turns, I is a total current, and S is a cross-sectional area of the 
coil. 

Several blocks with the same number of ampere-turns specified can be considered as 
connected in series. In that case current density in each block would be calculated as 
common total ampere-turns divided by the square of the block. 

In axisymmetric case if total number of ampere-turns is specified resulting current 
density could be described as varies as 1/r, where r is a radius coordinate of the point. 
This approach allows simulate massive spiral coils. 

Boundary Conditions 
The following boundary conditions can be specified at outward and inner boundaries 
of the region. 

Dirichlet condition specifies a known value of vector magnetic potential A0 at the 
vertex or at the edge of the model. This boundary condition defines normal 
component of the flux density vector. It is often used to specify vanishing value of 
this component, for example at the axis of symmetry or at the distant boundary. 
QuickField also supports the Dirichlet condition with a function of coordinates, it has 
the form 

A a bx cy0 = + +    for planar problems; 

rA a bzr
cr

0

2

2
= + +    for axisymmetric problems. 

Parameters a, b and c are constants for each edge, but can vary from one piece of the 
boundary to another. This approach allows you to model an uniform external field by 
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specifying non zero normal component of the flux density at arbitrary straight 
boundary segment. 

Let α be an elevation angle of the segment relative to the horizontal axis (x in planar 
or z in axisymmetric case). Then in both plane and axisymmetric cases the normal 
flux density is 

B c bn = +sin cosα α . 

Here we assume right-hand direction of positive normal vector. 

Choice of constant terms a for different edges has to satisfy the continuity conditions 
for function A0 at all edges' junction points. 

Note. For problem to be defined correctly the Dirichlet condition has to be specified 
at least at one point. If the region consists of two or more disjoint subregions, the 
Dirichlet conditions have to be specified at least at one point of the each part. Zero 
Dirichlet condition is defaulted at the axis of rotation for the axisymmetric problems. 

Neumann condition has the following form 

Ht = σ    at outward boundaries, 

H Ht t
+ −− = σ    at inner boundaries, 

where Ht is a tangent component of magnetic field intensity, "+" and "−" superscripts 
denote quantities to the left and to the right side of the boundary and σ is a linear 
density of the surface current. If σ value is zero, the boundary condition is called 
homogeneous. This kind of boundary condition is often used at an outward boundary 
of the region that is formed by the plane of magnetic antisymmetry of the problem 
(opposite sources in symmetrical geometry). The homogeneous Neumann condition is 
the natural one, it is assumed by default at all outward boundary parts where no 
explicit boundary condition is specified. 

Note. Zero Dirichlet condition is defaulted at the axis of rotation for the axisymmetric 
problems. 

If the surface electric current is to be specified at the plane of problem symmetry and 
this plane forms the outward boundary of the region, the current density has to be 
halved. 
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Zero flux boundary condition is used to describe superconducting materials that are 
not penetrated by the magnetic field. Vector magnetic potential is a constant within 
such superconducting body (rA = const in axisymmetric case), therefore 
superconductor's interior can be excluded from the consideration and the constant 
potential condition can be associated with its surface. 

Note. If the surface of a superconductor has common points with any Dirichlet edge, 
the whole surface has to be described by the Dirichlet condition with an appropriate 
potential value. 

Permanent Magnets 
Since the coercive force is considered in QuickField to be the piecewise constant 
function, its contribution to the equation is equivalent to surface currents which flow 
along the surface of the permanent magnet in direction orthogonal to the model plane. 
The density of such effective current is equal to jump of the tangent component of the 
coercive force across the magnet boundary. For example, rectangular magnet with the 
coercive force Hc directed along x-axis can be replaced by two oppositely directed 
currents at its upper and lower surfaces. The current density at the upper edge is 
numerically equal to Hc, and −Hc at the lower edge. 

Therefore, the permanent magnet can be specified by either coercive force or 
Neumann boundary conditions at its edges. You can choose more convenient and 
obvious way in each particular case. 

Permanent magnets with nonlinear magnetic properties need some special 
consideration. Magnetic permeability is assumed to be defined by the following 
equation 

( )( ) ( )B B H H B
B

H Hc
c

= + =
+

µ µ; . 
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It must be pointed out that µ(B) dependence is different from the analogous curve for 
the same material but without permanent magnetism. If the real characteristic for the 
magnet is not available for you, it is possible to use row material curve as an 
approximation. If you use such approximation and magnetic field value inside magnet 
is much smaller than its coercive force, it is recommended to replace the coercive 
force by the following effective value 

( )
′ =H

B
Bc

r
r

1
µ

, 

where Br is remanent induction. 

Calculated Physical Quantities 
For magnetostatic problems the QuickField postprocessor calculates the following set 
of local and integral physical quantities. 

Local quantities: 

• Vector magnetic potential A (flux function rA in axisymmetric case); 
• Vector of the magnetic flux density B = curl A 

B
A
y

B
A
xx y= = −

∂
∂

∂
∂

,    for planar case; 

( )
B

r
rA
r

B
A
zz r= = −

1 ∂
∂

∂
∂

,    for axisymmetric case; 

• Vector of magnetic field intensity H = µ−1B, where µ is the magnetic permeability 
tensor. 

Integral quantities: 

• Total magnetostatic force acting on bodies contained in a particular volume 

( ) ( ) ( )( )F H n B B n H n H B= ⋅ + ⋅ − ⋅∫
1
2

ds , 

where integral is evaluated over the boundary of the volume, and n denotes the 
vector of the outward unit normal. 

• Total torque of magnetic forces acting on bodies contained in a particular volume 
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( )( ) ( )( ) ( )( )( )T r H n B r B n H r n H B= × ⋅ + × ⋅ − × ⋅∫
1
2

ds , 

where r is a radius vector of the point of integration. 

The torque vector is parallel to z-axis in the planar case, and is identically equal to 
zero in the axisymmetric one. The torque is considered relative to the origin of the 
coordinate system. The torque relative to any other arbitrary point can be obtained 
by adding extra term of F × r0, where F is the total force and r0 is the radius 
vector of the point. 

• Magnetic field energy 

( )W dV= ⋅∫
1
2

H B    linear case; 

( )W H B dB dV
B

= ′ ′








∫∫

0

   nonlinear case. 

• Flux linkage per one turn of the coil 

Ψ = ∫ Ads

S
   for planar case; 

Ψ = ∫2π rAds

S
   for axisymmetric case; 

the integral has to be evaluated over the cross section of the coil, and S is the area 
of the cross section. 

For planar problems all integral quantities are considered per unit length in 
z-direction. 

The domain of integration is specified in the plane of the model as a closed contour 
consisting of line segments and circular arcs. 

Inductance Calculation 
To get self inductance of a coil, leave the current on in this coil only and make sure 
that all other currents are turned off. After solving the problem go to the 
Postprocessor and obtain flux linkage for the contour coinciding with the cross 
section of the coil. Once you�ve done that, the inductance of the coil can be obtained 
from the following equation: 
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L
n

I
=

Ψ
, 

where n is a number of turns in the coil, Ψ is a flux linkage, j is a current per one turn 
of the coil. 

Mutual inductance between two coils can be obtained in a similar way. The only 
difference from the previous case is that electric current has to be turned on in one 
coil, and the flux linkage has to be evaluated over the cross section of another. 

L
n

I12
2 2

1

=
Ψ

 

In plane-parallel case every coil has to be represented by at least two conductors with 
equal but opposite currents. In some cases both conductors are modeled, in other 
cases only one of two conductors is included in the model and the rest is replaced by 
the boundary condition A = 0 at the plane of symmetry. If the magnetic system is 
symmetric, the inductance can be obtained based on the flux linkage for one of the 
conductors only. The result has to be then multiplied by a factor of two to account for 
the second conductor. If the model is not symmetric, then the total inductance can be 
obtained by adding up the analogous terms for each conductor. Note that the current 
should be turned on in all conductors corresponding to one coil. 

In plane-parallel case the inductance is calculated per unit length in z-direction. 

Time-Harmonic Magnetic Field 
Time-harmonic electromagnetic analysis is the study of electric and magnetic fields 
arising from the application of an alternating (AC) current source, or an imposed 
alternating external field. 

Variation of the field with respect to time is assumed to be sinusoidal. All field 
components and electric currents vary with time like 

z z t z= +0 cos( )ω φ , 

where z0 is a peak value of z, φz � its phase angle, and ω � the angular frequency. 
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Complex representation of harmonic time dependency facilitates multiple phase 
analysis based on one complex solution. Real and imaginary parts of a complex 
quantity 

( )z z ei t z= +
0

ω φ , 

have phase angles shifted by 90 degrees, and their linear combination may be used to 
represent any arbitrary phase angle. 

Depending on the phase shift between two oscillating components of a vector, the 
vector can rotate clockwise or counterclockwise, or oscillate along certain direction. 
Generally, the end of such a vector draws an ellipse. The semimajor axis of the ellipse 
corresponds to the peak value of the vector. The ratio between minor and major axes 
of the ellipse defines the coefficient of polarization. The coefficient of polarization is 
assumed to be positive for the counterclockwise and negative for the clockwise 
rotation. Zero coefficient corresponds to the linear polarization. 

Total current in a conductor can be considered as a combination of a source current 
produced by the external voltage and an eddy current induced by the oscillating 
magnetic field 

j j j= +0 eddy  

The problem is formulated as a partial differential equation for the complex amplitude 
of vector magnetic potential A (B = curl A, B magnetic flux density vector). The 
flux density is assumed to lie in the plane of model (xy or zr), while the vector of 
electric current density j and the vector potential A are orthogonal to it. Only jz and Az 
in planar or jθ and Aθ in axisymmetric case are not equal to zero. We will denote them 
simply j and A. The equation for planar case is 
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and for axisymmetric case is 
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where electric conductivity g and components of magnetic permeability tensor µx and 
µy (µz and µr) are constants within each block of the model. Source current density j0 
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is assumed to be constant within each model block in planar case and vary as 1/r in 
axisymmetric case. 

The described formulation ignores displacement current density term ∂ ∂D t  in the 
Ampere�s Law. Typically the displacement current density is not significant until the 
operating frequency approaches the MHz range. 

Note. Permanent magnets and nonlinear magnetic properties cannot be simulated in a 
time-harmonic analysis. Since the entire field must vary sinusoidally, this would 
prevent permanent magnets or effects of saturation from being simulated using the 
harmonic analysis. Permanent magnets supply a constant flux to the system. 
Saturation of the material indicates that as the field intensity increases, the flux 
density in the material would not be able to follow the same sinusoidal behavior. 

Field Sources 
The field sources can be specified in the blocks, at the edges or at the individual 
vertices of the model. Possible field sources include space, surface and linear electric 
currents and voltages  applied to conductive areas. 

A point source in the xy-plane corresponds to a linear current in out-of-plane 
direction. In axisymmetric case the point source represents the current in a thin ring 
around the axis of symmetry. Edge-bound source in the plane of model represents a 
surface current in three-dimensional world. It is specified by the Neumann boundary 
condition for the edge. 

There are several ways to specify space-distributed electric current. In a massive 
conductor, you can specify either a total current or a voltage applied to the conductor. 
In planar problems, voltage drop is specified per unit depth of the model, and in 
axisymmetric case voltage is assumed per one turn around the axis of symmetry. 
Nonzero voltage applied to a conductor in axisymmetric problem means that the 
conductor has a radial cut, and the voltage is applied to sides of the cut. In practice 
this option could be used to describe known voltage applied to massive spiral wiring, 
in which case the total voltage drop for the coil should be divided by number of turns 
in the coil. 

Several blocks with the same value of total current or voltage applied can be 
considered as connected in series. In that case each conductor carries the same total 
current, and voltage (if any) is applied to the terminals of the whole group of 
conductors connected in series. 
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Note. The meanings of zero total current and zero voltage applied to a conductor are 
very different. Zero voltage means that the conductor�s ends are short circuit, and zero 
value of the total current means open ends of the conductor. 

Field source could also be specified in non-conductive areas. This option is useful to 
specify current in coils made of thin wire, where skin effect is insignificant. You can 
specify either a total current or a current density, whichever is easier to calculate in a 
specific case. Current density in a coil can be obtained from the equation 

j
n I
S

=
⋅

, 

where n is a number of turns, I is a total current, and S is a cross-sectional area of the 
coil. 

Note. In order to properly model thin wire coils, the source current density j0 in 
non-conductive areas is assumed to be uniform in both plane and axisymmetric cases. 
Its behavior is different for massive conductors, where source current density varies 
as 1/r in axisymmetric case. 

Boundary Conditions 
The following boundary conditions can be specified at outward and inner boundaries 
of the region. 

Dirichlet condition specifies a known value of vector magnetic potential A0 at the 
vertex or at the edge of the model. This boundary condition defines normal 
component of the flux density vector. It is often used to specify vanishing value of 
this component, for example at the axis of symmetry or at the distant boundary. 
QuickField also supports the Dirichlet condition with a function of coordinates, it has 
the form 

A a bx cy0 = + +    for planar problems; 

rA a bzr
cr

0

2

2
= + +    for axisymmetric problems. 

Parameters a, b and c are constants for each edge, but can vary from one piece of the 
boundary to another. This approach allows you to model an uniform external field by 
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specifying non zero normal component of the flux density at arbitrary straight 
boundary segment. 

Let α be an elevation angle of the segment relative to the horizontal axis (x in planar 
or z in axisymmetric case). Then in both plane and axisymmetric cases the normal 
flux density is 

B c bn = +sin cosα α . 

Here we assume right-hand direction of positive normal vector. 

Choice of constant terms a for different edges has to satisfy the continuity conditions 
for function A0 at all edges' junction points. 

Neumann condition has the following form 

Ht = σ    at outward boundaries, 

H Ht t
+ −− = σ    at inner boundaries, 

where Ht is a tangent component of magnetic field intensity, "+" and "−" superscripts 
denote quantities to the left and to the right side of the boundary and σ is a linear 
density of the surface current. If σ value is zero, the boundary condition is called 
homogeneous. This kind of boundary condition is often used at an outward boundary 
of the region that is formed by the plane of magnetic antisymmetry of the problem 
(opposite sources in symmetrical geometry). The homogeneous Neumann condition is 
the natural one, it is assumed by default at all outward boundary parts where no 
explicit boundary condition is specified. 

Note. Zero Dirichlet condition is defaulted at the axis of rotation for the axisymmetric 
problems. 

If the surface electric current is to be specified at the plane of problem symmetry and 
this plane forms the outward boundary of the region, the current density has to be 
halved. 

Zero flux boundary condition is used to describe superconducting materials that are 
not penetrated by the magnetic field. Vector magnetic potential is a constant within 
such superconducting body (rA = const in axisymmetric case), therefore 
superconductor's interior can be excluded from the consideration and the constant 
potential condition can be associated with its surface. 
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Note. If the surface of a superconductor has common points with any Dirichlet edge, 
the whole surface has to be described by the Dirichlet condition with an appropriate 
potential value. 

Calculated Physical Quantities 
The following local and integral physical quantities are calculated in the process of 
harmonic magnetic field analysis. 

Local quantities: 

• Complex amplitude of vector magnetic potential A (flux function rA in 
axisymmetric case); 

• Complex amplitude of voltage U applied to the conductor; 
• Complex amplitude of total current density j = j0 + jeddy, source current density j0 

and eddy current density jeddy  = −iωgA; 
• Complex vector of the magnetic flux density B = curl A 

B
A
y

B
A
xx y= = −

∂
∂

∂
∂

,    for planar case; 

( )
B

r
rA
r

B
A
zz r= = −

1 ∂
∂

∂
∂

,    for axisymmetric case; 

• Complex vector of magnetic field intensity H = µ-1B, where µ is the magnetic 
permeability tensor; 

• Time average and peak Joule heat density Q = g-1 j2; 
• Time average and peak magnetic field energy density ( )w = ⋅B H 2 ; 
• Time average Poynting vector (local power flow) S E H= × ; 
• Time average Lorentz force density vector F j B= × ; 
• Magnetic permeability µ (its largest component in anisotropic media); 
• Electric conductivity g. 

Integral quantities: 

• Complex magnitude of electric current through a particular surface 

I jds= ∫  

and its source and eddy components I0 and Ie. 

• Time average and peak Joule heat in a volume 
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Q g j dV= −∫ 1 2 . 

• Time average and peak magnetic field energy 

( )W dV= ⋅∫
1
2

H B . 

• Time average and peak power flow through the given surface (Poynting vector 
flow) 

S ds= ⋅∫ ( )S n . 

• Time average and oscillating part of Maxwell force acting on bodies contained in 
a particular volume 

( ) ( ) ( )( )F H n B B n H n H B= ⋅ + ⋅ − ⋅∫
1
2

ds , 

where integral is evaluated over the boundary of the volume, and n denotes the 
vector of the outward unit normal. 

• Time average and peak Maxwell force torque acting on bodies contained in a 
particular volume 

( )( ) ( )( ) ( )( )( )T r H n B r B n H r n H B= × ⋅ + × ⋅ − × ⋅∫
1
2

ds , 

where r is a radius vector of the point of integration. 

• Time average and oscillating part of Lorentz force acting on conductors 
contained in a particular volume 

F j B= ×∫ dV . 

• Time average and peak Lorentz force torque acting on bodies contained in a 
particular volume 

( )T r j B= × ×∫ dV , 

where r is a radius vector of the point of integration. 

The torque vector is parallel to z-axis in the planar case, and is identically equal to 
zero in the axisymmetric one. The torque is considered relative to the origin of the 
coordinate system. The torque relative to any other arbitrary point can be obtained 
by adding extra term of F × r0, where F is the total force and r0 is the radius 
vector of the point. 
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Note. Magnetic field produces forces acting on the current carrying conductors and on 
the ferromagnetic bodies. The force acting on conductors is known as Lorentz force, 
while the Maxwell force incorporates both components. 

The domain of integration is specified in the plane of the model as a closed contour 
consisting of line segments and circular arcs. 

Impedance Calculation 
Impedance in time-harmonic electromagnetic analysis is a complex coefficient 
between complex values of current and voltage, V = ZI. Its real part represents active 
resistance of the conductor, calculated with the skin effect taken into account. The 
imaginary part of the impedance is the inductance multiplied by the angular frequency 
ω. 

Z R i L= + ω . 

As values of voltage and current in any conductor are easily accessible in the 
postprocessor, you can determine the impedance by dividing voltage by current using 
complex arithmetic. Let V and I be peak values of voltage and current, and φV and φI 
be phases of those quantities. Then the active resistance could be calculated as 

( )R V
I V I= −cos φ φ , 

and the inductance as 

( )L V
I f V I=
⋅

−
2π

φ φsin . 

To get mutual inductance between two conductors, you can specify nonzero total 
current in one of them, make the ends of the other open (applying zero total current), 
and measure the voltage induced in the second conductor by the current in the first 
one. 

Note. As in planar case voltage is applied and measured per unit length, the 
impedance is also calculated per unit length in z-direction. 
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Electrostatics 
Electrostatic problems are described by the Poisson's equation for scalar electric 
potential U (E = −−−−gradU, E electric field intensity vector). The equation for planar 
case is 
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and for axisymmetric case is 
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where components of electric permittivity tensor εx, εy or εz, εr and electric charge 
density ρ are constants within each block of the model. 

Field Sources 
QuickField provides possibility to specify electric charges located in the blocks, at the 
edges or at the individual vertices of the model. The electric charge specified at a 
point of the xy-plane corresponds to a charged string which is perpendicular to the 
plane of the model, and is described by the linear charge density. In axisymmetric 
case the vertex charge represents a charged circle around the axis of symmetry or a 
point charge located on the axis. To incorporate both these cases a total charge value 
is associated with the vertex. For the charged circle the total charge is connected with 
its linear density by the relationship q = 2πr⋅ρ. Edge-bound charge in the plane of 
model represents a surface-bound charge in three-dimensional world. It is described 
by surface charge density and is specified by the Neumann boundary condition for the 
edge. The charge density associated with a block is equivalent to the space charge. 

Boundary Conditions 
The following boundary conditions can be specified at outward and inner boundaries 
of the region. 

Dirichlet condition electric potential: specifies a known value of electric potential U0 
at the vertex or at the edge of the model (for example on a capacitor plate). This kind 
of boundary condition is also useful at an outward boundary of the region that is 
formed by the plane of electric antisymmetry of the problem (opposite charges in 
symmetrical geometry). U0 value at the edge can be specified as a linear function of 
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coordinates. The function parameters can vary from one edge to another, but have to 
be adjusted to avoid discontinuities at edges' junction points. 

Note. For problem to be defined correctly the Dirichlet condition has to be specified 
at least at one point. If the region consists of two or more disjoint subregions, the 
Dirichlet conditions have to be specified at least at one point of every part. 

Neumann condition is defined by the following equations: 

σ=nD    at outward boundaries, 

σ=− −+
nn DD    at inner boundaries, 

where Dn is a normal component of electric induction, "+" and "−" superscripts denote 
quantities to the left and to the right side of the boundary, σ is a surface charge 
density. If σ value is zero, the boundary condition is called homogeneous. It indicates 
vanishing of the normal component of electric field intensity vector. This kind of 
boundary condition is used at an outward boundary of the region that is formed by the 
symmetry plane of the problem. The homogeneous Neumann condition is the natural 
one, it is defaulted at all outward boundary parts where no explicit boundary 
condition is specified. 

If the surface-bound charge is to be specified at the plane of problem symmetry and 
this plane is the outward boundary of the region, the surface charge density has to be 
halved. 

Constant potential boundary condition is used to describe surface of an isolated 
�floating� conductor that has constant but unknown potential value. 

Note. The edge described as possessing constant potential should not have common 
points with any Dirichlet edge. In that case the constant potential edge has to be 
described by a Dirichlet condition with appropriate potential value. 

Calculated Physical Quantities 
For electrostatic problems the QuickField postprocessor calculates the following set 
of local and integral physical quantities. 
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Local quantities: 

• Scalar electric potential U; 
• Vector of electric field intensity E = −gradU 
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• Tensor of the gradient of electric field intensity G = gradE 
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and also its principal components G1 and G2. 

• Vector of electric induction D = εE, where ε is electric permittivity tensor. 

Integral quantities: 

• Total electric charge in a particular volume 

∫ ⋅= dsq nD , 

where integral is evaluated over the boundary of the volume, and n denotes the 
vector of the outward unit normal. 

• Total electrostatic force acting on bodies contained in a particular volume 

( ) ( ) ( )( )ds∫ ⋅−⋅+⋅= DEnEnDDnEF
2
1  

• Total torque of electrostatic forces acting on bodies contained in a particular 
volume 

( )( ) ( )( ) ( )( )( )∫ ⋅×−⋅×+⋅×= dsDEnrEnDrDnErT
2
1  

where r is a radius vector of the point of integration. 
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The torque vector is parallel to z-axis in planar case, and is identically equal to 
zero in axisymmetric one. The torque is considered relative to the origin of the 
coordinate system. The torque relative to any other arbitrary point can be obtained 
by adding extra term of F × r0, where F is the total force and r0 is the radius 
vector of the point. 

• Energy of electric field 

( )∫ ⋅= dVW DE
2
1 . 

For planar problems all integral quantities are considered per unit length in 
z-direction. 

The domain of integration is specified in the plane of the model as a closed contour 
consisting of line segments and circular arcs. 

Capacitance Calculation 
There are several ways to calculate capacitance using QuickField. The easiest one of 
them is based on measuring an electric potential produced by a known charge. To get 
capacitance of a conductor, put constant potential boundary condition on its surface, 
specify an arbitrary non zero electric charge in one of the vertices on the surface of 
the conductor (in fact, the charge will be distributed over the conductor�s surface), 
and turn off all other field sources in the model. Once the problem is solved, go to the 
Postprocessor and take the value of electric potential somewhere on the surface of the 
conductor. The capacitance of the conductor can be obtained from the equation 

U
qC = , 

where q is the electric charge and U is the potential of the conductor. 

To calculate mutual capacitance between two conductors put a charge on one 
conductor and measure electric potential on another. Constant potential boundary 
condition has to be applied to the surfaces of both conductors. 

2

1
12 U

qC = . 

Other ways of calculating capacitance are demonstrated in example “Elec1: 
Microstrip Transmission Line”. 
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Current Flow Analysis 
QuickField is able to calculate the distribution of electric current in systems of 
conductors. The problems of current distribution are described by the Poisson's 
equation for scalar electric potential U. 

The equation for planar case is 
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where components of electric resistivity tensor ρx, ρy or ρz, ρr are constant within each 
model block. 

The electric current density j can be obtained from the equation j ==== −−−−ρ−1⋅grad U, 
where ρ−1 is an inverse tensor of electric resistivity. 

Field Sources 
With the problems of current flow, the field sources are external currents supplied to 
the boundary of a conductor. QuickField provides possibility to specify external 
current density at the edges or at the individual vertices of the model. The current 
density specified at a point of the xy-plane corresponds to a knife-edge current 
collector which is perpendicular to the plane of the model, and is described by the 
linear current density. In axisymmetric case the vertex source represents a circular 
collector around the axis of symmetry or a point collector located on the axis. To 
incorporate both these cases, a total current value is associated with the vertex. For 
the circular knife-edge collector the total current value is connected with its linear 
density by the relationship I = 2πr⋅σ. Edge-bound current density in the plane of 
model represents a surface-bound external current density in three-dimensional world. 
It is specified by the Neumann boundary condition for the edge. 

Boundary Conditions 
The following boundary conditions can be specified at outward and inner boundaries 
of the region. 
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Dirichlet condition electric potential: specifies a known value of electric potential U0 
at the vertex or at the edge of the model. U0 value at the edge can be specified as a 
linear function of coordinates. The function parameters can vary from one edge to 
another, but have to be adjusted to avoid discontinuities at edges' junction points. 

Note. For problem to be defined correctly the Dirichlet condition has to be specified 
at least at one point. If the region consists of two or more disjoint subregions, the 
Dirichlet conditions have to be specified at least at one point of every part. 

Neumann condition is defined by the following equations: 

j jn =    at outward boundaries, 

j j jn n
+ −− =    at inner boundaries, 

where jn is a normal component of the current density vector, "+" and "−" superscripts 
denote quantities to the left and to the right side of the boundary, and j at right hand 
side is a density of the external current. If j value is zero, the boundary condition is 
called homogeneous. This kind of boundary condition is used at an outward boundary 
of the region that is formed by the symmetry plane of the problem. The homogeneous 
Neumann condition is the natural one, it is defaulted at all outward boundary parts 
where no explicit boundary condition is specified. 

If the surface-bound current density is to be specified at the plane of problem 
symmetry and this plane is the outward boundary of the region, the surface current 
density has to be halved. 

Constant potential boundary condition is used to describe surface of a conductor 
having much greater conductivity than the surrounding medium. This conductor is 
assumed to have constant but unknown potential value. 

Note. The edge described as possessing constant potential should not have common 
points with any Dirichlet edge. In that case the constant potential edge has to be 
described by the Dirichlet condition with an appropriate potential value. 

Calculated Physical Quantities 
For problems of current flow, the QuickField postprocessor calculates the following 
set of local and integral physical quantities. 
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Local quantities: 

• Scalar electric potential U; 
• Vector of electric field intensity E = −gradU 
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• Vector of current density j = ρ−1E, where ρ is electric resistivity tensor. 

Integral quantities: 

• Electric current through a given surface 

I ds= ⋅∫ j n , 

where n denotes the vector of the unit normal. 

• Joule heat produced in a volume 

W dV= ⋅∫E j . 

For planar problems all integral quantities are considered per unit length in z 
direction. 

The domain of integration is specified in the plane of the model as a closed contour 
consisting of line segments and circular arcs. 

Heat Transfer 
With QuickField you can analyze linear and nonlinear temperature fields in one of 
two formulations: steady state or transient: heating or cooling of the system. 

Heat-transfer equation for linear problems is: 
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for nonlinear problems: 
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where: 

T � temperature; 

t � time; 

λx(y,z,r) � components of heat conductivity tensor; 

λ(T) � heat conductivity as a function of temperature approximated by cubic 
spline (anisotropy is not supported in nonlinear case); 

q(T) � volume power of heat sources, in linear case�constant, in nonlinear 
case�function of temperature approximated by cubic spline. 

c(T) � specific heat, in nonlinear case�function of temperature approximated 
by cubic spline; 

ρ � density of the substance. 

In steady state case the last term in these equations equals zero. 

In linear case all the parameters are constants within each block of the model. 

The heat transfer problems for thin plates are very analogous to the plane-parallel 
problems and we will not discuss them especially. 

Heat Sources 
QuickField provides possibility to specify the heat sources located in the blocks, at 
the edges or at the individual vertices of the model. The heat source specified at a 
point of the xy-plane corresponds to a linear string-like heater which is perpendicular 
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to the plane of the model, and is described by the generated power per unit length. In 
axisymmetric case the vertex heat source represents a heating circle around the axis of 
symmetry or a point heater located on the axis. To incorporate both these cases a total 
generated power value is associated with the vertex. For the heating circle the total 
power is connected with its linear density by the relationship q = 2πr⋅ql. Edge-bound 
heat source in the plane of model represents a surface heat source in 
three-dimensional world. It is described by power per unit area and is specified by the 
Neumann boundary condition for the edge. The volume power density associated with 
a block corresponds to the volume heat source. 

Boundary Conditions 
The following boundary conditions can be specified at outward and inner boundaries 
of the region. 

Known temperature boundary condition (known also as boundary condition of the 
first kind) specifies a known value of temperature T0 at the vertex or at the edge of the 
model (for example on a liquid-cooled surface). T0 value at the edge can be specified 
as a linear function of coordinates. The function parameters can vary from one edge to 
another, but have to be adjusted to avoid discontinuities at edges' junction points. 

This boundary condition sometimes is called the boundary condition of the first kind. 

Heat flux boundary condition (known also as boundary condition of the second 
kind) is defined by the following equations: 

F qn s= −    at outward boundaries, 

F F qn n s
+ −− = −    at inner boundaries, 

where Fn is a normal component of heat flux density, "+" and "−" superscripts denote 
quantities to the left and to the right side of the boundary. For inner boundary qs, 
denotes the generated power per unit area, for outward boundary it specifies the 
known value of the heat flux density across the boundary. If qs, value is zero, the 
boundary condition is called homogeneous. The homogeneous condition at the 
outward boundary indicates vanishing of the heat flux across the surface. This type of 
boundary condition is the natural one, it is defaulted at all outward boundary parts 
where no explicit boundary condition is specified. This kind of boundary condition is 
used at an outward boundary of the region which is formed by the symmetry plane of 
the problem. 
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If the surface heat source is to be specified at the plane of problem symmetry and this 
plane constitutes the outward boundary of the region, the surface power has to be 
halved. 

This boundary condition sometimes is called the boundary condition of the second 
kind. 

Convection boundary condition can be specified at outward boundary of the region. 
It describes convective heat transfer and is defined by the following equation: 

( )F T Tn = −α 0 , 

where α is a film coefficient, and T0 temperature of contacting fluid medium. 
Parameters α and T0 may differ from part to part of the boundary. 

This boundary condition sometimes is called the boundary condition of the third kind. 

Radiation boundary condition can be specified at outward boundary of the region. 
It describes radiative heat transfer and is defined by the following equation: 

( )F k T Tn = −SBβ 4
0
4 , 

where kSB is a Stephan-Boltsman constant, β is an emissivity coefficient, and T0�
ambient radiation temperature. Parameters β and T0 may differ from part to part of the 
boundary. 

Note. For heat transfer problem to be defined correctly the known temperature 
boundary condition, or the convection, or the radiation has to be specified at least at 
some parts of the boundary. 

Constant temperature boundary condition may be used to describe bodies with 
very high heat conductivity. You can exclude interior of these bodies from the 
consideration and describe their surface as the constant temperature boundary. 

Note. The edge described as possessing constant temperature cannot have common 
points with any edge where the temperature is specified explicitly. In that case the 
constant temperature edge has to be described by the boundary condition of the first 
kind with an appropriate temperature value. 
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Calculated Physical Quantities 
For heat transfer problems the QuickField postprocessor calculates the following set 
of local and integral physical quantities. 

Local quantities: 

• Temperature T; 
• Vector of the heat flux density F = −λ grad T 

F
T
x

F
T
yx x y y= − = −λ

∂
∂

λ
∂
∂

,    for planar case; 

F
T
z

F
T
rz z r r= − = −λ

∂
∂

λ
∂
∂

,    for axisymmetric case; 

The postprocessor can calculate the heat flux through an arbitrary closed or unclosed 
surface 

Φ = ⋅∫F nds , 

where n denotes the unit vector of normal to the surface. The surface is specified by a 
contour consisting of line segments and circular arcs in the plane of the model. 

Stress Analysis 
Within QuickField package, the plane stress, the plane strain and the axisymmetric 
stress models are available with both isotropic and orthotropic materials. The plane 
stress model is suitable for analyzing structures that are thin in the out-of-plane 
direction, e.g., thin plates subject to in-plate loading. Out-of-plane direct stress and 
shear stresses are assumed to be negligible. The plane strain model is formulated by 
assuming that out-of-plane strains are negligible. This model is suitable for structures 
that are thick in the out-of-plane direction. 

Displacement, Strain and Stress 
The displacement field is assumed to be completely defined by the two components 
of the displacement vector δ in each point: 

{ }δ δ
δ

=








x

y
   for plane problems; 



  Stress Analysis 109 

{ }δ δ
δ

=








z

r
   for axisymmetric problems. 

Only three components of strain and stress tensors are independent in both plane 
stress and plane strain cases. The strain-displacement relationship is defined as: 

{ }ε
ε
ε
γ

∂δ
∂
∂δ
∂

∂δ
∂

∂δ
∂

=
















=

+





























x

y

xy

x

y

x y

x

y

y x

. 

The corresponding stress components: 

{ }σ
σ
σ
τ

=
















x

y

xy

. 

The axisymmetric problem formulation also includes the out-of-plane direct strain εθ, 
caused by the radial deformation. The strain-displacement relationship is defined as: 

{ }ε

ε
ε
ε
γ

∂δ
∂
∂δ
∂
δ

∂δ
∂

∂δ
∂

θ
=



















=

+


































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r

z r

z

r

r

r z

. 

The corresponding stress components: 

{ }σ

σ
σ
σ
τ

θ
=



















z

r

rz

. 
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The equilibrium equations for the plane problems are: 

∂σ
∂

∂τ
∂

∂τ
∂

∂σ
∂

x xy
x

xy y
y

x y
f

x y
f

+ = −

+ = −









 ,

 

and for the axisymmetric problems are: 

( )

( )

1

1

r
r
r z

f

r
r

r z
f

r rz
r

rz z
z

∂ σ
∂

∂τ
∂

∂ τ
∂

∂σ
∂

+ = −

+ = −











 ,

 

where ƒx, ƒy and ƒz, ƒr are components of the volume force vector. 

For linear elasticity, the stresses are related to the strains using relationship of the 
form 

{ } [ ] { } { }( )σ ε ε= −D 0 , 

where [ ]D  is a matrix of elastic constants, and {ε 0}  is the initial thermal strain. The 
specific form of the matrix depends on a particular problem formulation. 

For plane stress and isotropic material: 

[ ]D
E

=
− −



















1

1 0
1 0

0 0
1

2

2ν

ν
ν

ν
. 

For plane stress and orthotropic material: 

[ ]D

E E

E E

G

x

yx

y

yx

y y

xy

=

−

−

























−
1 0

1 0

0 0 1

1ν

ν
. 
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For plane strain and isotropic material: 

[ ] ( )
( )( )

( )

D
E

=
−

+ −

−

−
−
−
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For plane strain and orthotropic material: 
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For axisymmetric problem and isotropic material: 
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For axisymmetric problem and orthotropic material: 
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In all these equations E denotes Young's modulus of the isotropic material; Ex, Ey, Ez, 
Er, and Eθ are the Young's moduli of the orthotropic material along the corresponding 
axes; ν is a Poisson's ratio for isotropic material; νyx, νzx, νzy, νrz, νθz, νθr are the 
Poisson's ratios for orthotropic material; Gxy and Gzr are the shear moduli. 

Thermal Strain 
Temperature strain is determined by the coefficients of thermal expansion and 
difference of temperatures between strained and strainless states. Components of the 
thermal strain for plane stress and isotropic material are defined by the following 
equation: 

{ }ε
α
α0

0
=















∆T ; 

plane stress, orthotropic material: 

{ }ε
α
α0

0
=
















x

y T∆ ; 

plane strain, isotropic material: 

{ } ( )ε ν
α
α0 1
0

= +















∆T ; 

plane strain, orthotropic material: 

{ }ε
α ν α
α ν α0

0
=

+
+

















x zx z

y zy z T∆ ; 

axisymmetric problem, isotropic material: 

{ }ε

α
α
α0

0

=



















∆T ; 
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axisymmetric problem, orthotropic material: 

{ }ε

α
α
α θ

0

0

=



















z

r T∆ , 

where α is a coefficient of thermal expansion for isotropic material; αx, αy, αz, αr, αθ 
are the coefficients of thermal expansion along the corresponding axes for orthotropic 
material; ∆T is the temperature difference between strained and strainless states. 

External Forces 
QuickField provides way to specify concentrated loads, surface and body forces. The 
concentrated loads are defined at vertices as two components of the corresponding 
vector. The surface forces at the edges of the model are specified by the vector 
components or by the normal pressure. The body forces are defined by their 
components within blocks of the model. Each component of the body force vector can 
be specified as a linear function of the coordinates. This feature can be used, for 
example, to model centrifugal forces. The normal pressure also can be linear function 
that is useful for hydrostatic pressure. 

Note. The concentrated load is specified by the force per thickness unit for plane 
problems and by the total force value for axisymmetric ones. In the last case the 
force can be applied to the point at the axis of symmetry or distributed along the circle 
around the axis. 

Any surface force which is directed along the normal to the surface can be described 
as a pressure. The pressure is considered positive if it is directed inside region at its 
outward boundary or from right to left at the inner boundary. Left and right are 
referred relative to the edge intrinsic direction, which is always counterclockwise for 
arcs and is determined for line segments by the order of picking vertices when the 
edge is created. 

Restriction Conditions 
Rigid constraint condition along one or both axes can be specified at any vertex or 
along any edge of the model. Prescribed displacement at restrained edge can be 
specified as a linear function of the coordinates. 
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Elastic support condition describes a vertex subject to springy force which is 
proportional to difference between actual and predetermined displacement. The 
elastic support condition is characterized by the predetermined displacement and the 
support elasticity. 

Note. For problem to be defined correctly the constraint or elastic support conditions 
have to be specified in such a way to exclude rigid body shifts and rotations of the 
model or its parts without increasing the potential energy. Two translational and one 
rotational degrees of freedom have to be restricted for plane problem, in axisymmetric 
case only shift in z-direction has to be excluded. 

Calculated Physical Quantities 
For the stress analysis problems the QuickField postprocessor calculates the following 
set of physical quantities: 

• The absolute value of displacement 

δ δ δ= +x y
2 2 , or δ δ δ= +z r

2 2 ; 

• Maximum and minimum principal stresses in the plane of model σ1 and σ2; 
• Normal and tangential stresses along coordinate axes σx, σy and τxy (σz, σr and τrz 

in axisymmetric case); 
• Normal stress in out-of-plane direction (σz�for xy-plane, σθ�for rz-plane). For 

the plane stress problems this component vanishes by the definition; 
• Von Mises criterion (stored energy of deformation): 

( ) ( ) ( )[ ]σ σ σ σ σ σ σe = − + − + −
1
2 1 2

2
2 3

2
3 1

2 ; 

where σ1, σ2 and σ3 denote the principal stresses in descending order. 

• Tresca criterion (maximum shear): 

σe = σ1 − σ3; 

• Mohr-Coulomb criterion: 

σe = σ1 − χσ3, 

where 

[ ]
[ ]

χ
σ
σ

= +

−

, 
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[σ+] and [σ−] denote tensile and compressive allowable stress. 

• Drucker-Prager criterion: 

( ) [ ]
σ χ σ

χ χ
χ

σ
σ

χ
χ

σe i= + −
−

+
+

−
+









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−

1
1

1 1
1

2

, 

where 

( ) ( ) ( )[ ]σ σ σ σ σ σ σi = − + − + −
1
2 1 2

2
2 3

2
3 1

2 ; 

σ
σ σ σ

=
+ +1 2 3

3
. 

• Hill failure index for orthotropic materials: 

F. I.= − + +
σ σ σ σ τ1

2

1
2

1 2

1
2

2
2

2
2

12
2

12
2X X X S

, 

where σ1, σ2 and τ12 are computed stresses in the material directions and, 

X X X XT C
1 1 1 10 0= > = <  if if1 1σ σ; ; 

X X X XT C
2 2 2 20 0= > = <if if2 2σ σ; ; 

S S S S12 12 12 120 0= > = <+ −if if12 12τ τ; , 

where X T
1 , X T

2 , X C
1 , X C

2 , S12
+  and S12

−  are tensile, compressive and shear 
allowable stresses. 

Coupled Problems 
QuickField is capable of importing loads (distributed sources) calculated in some 
problem into the problem of another type. Following coupling types are supported: 

• Heat transfer caused by Joule heat generated in the current flow or time-harmonic 
electromagnetic problem. 

• Thermal stresses based on a calculated temperature distribution. 
• Stress analysis of the system loaded by magnetic forces. 
• Stresses in electrostatic system. 



116 Chapter 8  Theoretical Description 

A special case of coupling allows for importing of the temperature distribution in 
some steady state or transient heat transfer problem into another transient heat transfer 
problem as its initial state. 

In addition to imported loads, you can define any other loads and boundary 
conditions, similar to non coupled problem. 

You can combine several coupling types in one problem. E.g., after calculating 
currents distribution, electrostatic and magnetic fields as separate problems based on 
the same model file, you can calculate temperature distribution from Joule heat and 
then find stresses caused by temperature and magnetic and electrostatic forces at once. 
However, such problems are rather rare. 

Further we will call the problem, from which the data are being loaded, the source 
problem, and the problem, which imports the data, the target problem. 

There are several rules to follow with coupled problems: 

• Both source and target problem must share a single model file. 
• Both problems must use the same formulation (plane or axisymmetric). 
• Source problem must be up-to-date when solving the target problem. 

Note. In spite of the requirement that both coupled problems must use the same model 
file, the geometrical region for the problems need not coincide, i.e., some subregions 
those are in use in one problem, could be excluded from consideration in the other 
one. 

Importing Joule Heat to Heat Transfer Problem 
While importing data from current flow problem to heat transfer one, heat sources due 
to Joule law are assumed in all subregions included into consideration in both source 
and target problems. In time-harmonic electromagnetic problems Joule heat is 
generated in all conductors. 

Importing Temperature Distribution to Stress Analysis 
Problem 
While calculating thermal stresses, initial strains are assumed in all subregions, which 
are included into consideration in both problems and possess nonzero value of 
thermal expansion coefficient (or at least one of its components in anisotropic case). 
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While importing the temperature distribution from the transient problem, you can 
choose the moment of time, the state at which you wish to import. 

Importing Magnetic Forces to Stress Analysis Problem 
While importing magnetic force to stress analysis problem: 

• Body force is assumed in all subregions included into consideration in both source 
and target problems, if those subregions have nonlinear magnetic properties and/or 
current density is defined (Lorentz force). 

• Surface force is assumed at the boundaries separating subregions with different 
magnetic properties, boundaries with surface current, or outward boundaries in 
sense of magnetic problem. The surface force is also generated in the cases, when 
only one subregion, say, to the left of the boundary is active in sense of magnetic 
problem, and only the subregion to the right of it is active in stress analysis 
problem. 

Importing Electrostatic Forces to Stress Analysis 
Problem 
While importing electrostatic force to stress analysis problem: 

• Body force is assumed for all subregions included into consideration in both 
source and target problems and carrying distributed charge density. 

• Surface force is assumed at the boundaries separating subregions with different 
permittivity, boundaries with surface charge, or outward boundaries in sense of 
electrostatic problem. The surface force is also generated in the cases, when only 
one subregion, say, to the left of the boundary is active in sense of electrostatic 
problem, and only the subregion to the right of it is active in stress analysis 
problem. 
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C H A P T E R  9  

Examples 

 

This chapter contains descriptions of the example problems supplied in the Examples 
folder. Each problem in this folder is represented by the complete database, which 
includes geometric model, finite element mesh, definition of material properties, 
loads and boundary conditions, and ready analysis results. Supplied analysis results 
allow you to look instantly at the postprocessing capabilities without spending time 
for preparing data and solving the problem. 

QuickField online Help contains detailed step-by-step description of the modeling 
process, data preparation, and postprocessing of the results for some of the examples 
described in this chapter. They are provided to illustrate effective modeling 
techniques and to give you an opportunity to learn QuickField by following an 
example. See Tutorial topic in online Help. 
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Magnetic Problems 
Magn1: Nonlinear Permanent Magnet 
A permanent magnet and a steel keeper in the air. 

Problem Type: 
A nonlinear plane-parallel problem of magnetostatics. 

Geometry: 

40

20

Steel

Steel

ALNICOHG

10

C

A

D

O

K

M

Q

10
JI

10
10

E F

B

P

20

L

N

R

 

All dimensions are in centimeters. 

The permanent magnets are made of ALNICO, coercive force is 147218 A/m. The 
polarizations of the magnets are along vertical axis opposite to each other. The 
demagnetization curve for ALNICO: 

H (A/m) -147218 -119400 -99470 -79580 -53710 -19890 0.0 

B (T) 0.0 0.24 0.4 0.5 0.6 0.71 0.77 
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The B-H curve for the steel: 

H (A/m) 400 600 800 1000 1400 2000 3000 4000 6000 

B (T) 0.73 0.92 1.05 1.15 1.28 1.42 1.52 1.58 1.60 

 

Comparison of Results 
Maximum flux density in Y-direction: 

ANSYS 0.42 

COSMOS/M 0.404 

QuickField 0.417 

See the Magn1.pbm problem in the Examples folder. 

Also see Tutorial topic in online Help for detailed step-by-step instructions for this 
example. 
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Magn2: Solenoid Actuator 
A solenoid actuator consists of a coil enclosed in a ferromagnetic core with a plunger. 
Calculate the magnetic field and a force applied to the plunger. 

Problem Type: 
A nonlinear axisymmetric problem of magnetics. 

Geometry: 
24

16
24

4

8
0.

2

Plunger

16

206 2

Core
Coil

 

All dimensions are in centimeters. 

Given: 
Relative permeability of air and coil µ = 1; 
Current density in the coil j = 1·106 A/m2; 
The B-H curve for the core and the plunger: 

H (A/m) 460 640 720 890 1280 1900 3400 6000 

B (T) 0.80 0.95 1.00 1.10 1.25 1.40 1.55 1.65 



  Magnetic Problems 123 

Problem: 
Obtain the magnetic field in the solenoid and a force applied to the plunger. 

Solution: 
This magnetic system is almost closed, therefore outward boundary of the model can 
be put relatively close to the solenoid core. A thicker layer of the outside air is 
included into the model region at the plunger side, since the magnetic field in this area 
cannot be neglected. 

Mesh density is chosen by default, but to improve the mesh distribution, three 
additional vertices are added to the model. We put one of this vertices at the coil inner 
surface next to the plunger corner, and two others next to the corner of the core at the 
both sides of the plunger. 

A contour for the force calculation encloses the plunger. It is put in the middle of the 
air gap between the plunger and the core. While defining the contour of integration, 
use a strong zoom-in mode to avoid sticking the contour to existing edges. 

The calculated force applied to the plunger F = 374.1 N. 

See the Magn2.pbm problem in the Examples folder. 

Comparison of Results 
Maximum flux density in Z-direction in the plunger: 

 Bz (T) 

Reference 0.933 

QuickField 1.0183 

Reference 
D. F. Ostergaard, "Magnetics for static fields", ANSYS revision 4.3, Tutorials, 1987. 
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Magn3: Ferromagnetic C-Magnet 
A permanent C-magnet in the air. The example demonstrates how to model curved 
permanent magnet using the equivalent surface currents. 

Problem Type: 
Plane problem of magnetics. 

Geometry of the magnet: 

7.
5

1

5

 

Given: 
Relative permeability of the air µ = 1; 
Relative permeability of the magnet µ = 1000; 
Coercive force of the magnet Hc = 10000 A/m. 

The polarization of the magnet is along its curvature. 

Solution: 
To avoid the influence of the boundaries while modeling the unbounded problem, 
we'll enclose the magnet in a rectangular region of air and specify zero Dirichlet 
boundary condition on its sides. 
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Magnetization of straight parts of the magnet is specified in terms of coercive force 
vector. Effective surface currents simulate magnetization in the middle curved part of 
the magnet. 

See the Magn3.pbm problem in the Examples folder. 
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Magn4: Electric Motor 
A brushless DC motor with permanent magnets and three phase coil excitation. 

Problem Type: 
A nonlinear plane-parallel problem of magnetostatics. 

Geometry: 
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Dimensions of the stator: 

R 23

0.75

R 17.5

R 12.5

R 14

R 20.5

1.
5

R 25

15.0°

 

Dimensions of the rotor: 

12.5

10

R 5

R 
12

 

All dimensions are in millimeters and degrees Axial length of the motor is 40 mm. 
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The four magnets are made of Samarium-Cobalt with relative permeability of 1.154 
and coercive force of 550000 A/m. The current densities for the coil slots are as 
follows: 1.3·106 A/m2 on R+, −1.3·106 A/m2 on R−, 1.3·106 A/m2 on S+, −1.3·106 A/m2 
on S−, and zero on T + and T −. The inner and outer frames are made of 
Cobalt-Nickel-Copper-Iron alloy. 

The B-H curve for the Cobalt-Nickel-Copper-Iron alloy: 

H  (A/m) 20 60 80 95 105 120 

B  (T) 0.19 0.65 0.87 1.04 1.18 1.24 

H  (A/m) 140 160 180 200 240 2500 

B  (T) 1.272 1.3 1.32 1.34 1.36 1.45 

The B-H curve for the steel: 

H  (A/m) 400 600 800 1000 1400 2000 3000 4000 6000 

B  (T) 0.73 0.92 1.05 1.15 1.28 1.42 1.52 1.58 1.60 

See the Magn4.pbm problem in the Examples folder. 

Also see Tutorial topic in online Help for detailed step-by-step instructions for this 
example. 
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Time-Harmonic Magnetic Problems 
HMagn1: Slot Embedded Conductor 

Problem Type: 
A plane problem of time-harmonic magnetic field. 

Geometry: 

 

A solid copper conductor embedded in the slot of an electric machine carries a current 
I at a frequency f. 

Given: 
Magnetic permeability of air µ = 1; 
Magnetic permeability of copper µ = 1; 
Conductivity of copper σ = 5.8005·107 S/m; 
Current in the conductor I = 1 A; 
Frequency f = 45 Hz. 
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Problem: 
Determine current distribution within the conductor and complex impedance of the 
conductor. 

Solution: 
We assume that the steel slot is infinitely permeable and may be replaced with a 
Neumann boundary condition. We also assume that the flux is contained within the 
slot, so we can put a Dirichlet boundary condition along the top of the slot. See 
HMagn1.pbm problem in the Examples folder for the complete model. 

The complex impedance per unit length of the conductor can be obtained from the 
equation 

Z
V
I

= , 

where V is a voltage drop per unit length. This voltage drop can be obtained in the 
Postprocessor (choose Results, Analyze, Values, Complex, and then pick an 
arbitrary point within the conductor.) 

Comparison of Results 
 

 Re Z (Ohm/m) Im Z (Ohm/m) 

Reference 1.7555·10−4 4.7113·10−4 

QuickField 1.7550·10−4 4.7111·10−4 

Reference 
A. Konrad, “Integrodifferential Finite Element Formulation of Two-Dimensional 
Steady-State Skin Effect Problems”, IEEE Trans. Magnetics, Vol MAG-18, No. 1, 
January 1982. 
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HMagn2: Symmetric Double Line of Conductors 

Problem Type: 
A plane problem of time-harmonic magnetic field. 

Geometry: 

 

Two copper square cross-section conductors with equal but opposite currents are 
contained inside rectangular ferromagnetic coating. All dimensions are in millimeters. 

Given: 
Magnetic permeability of air µ = 1; 
Magnetic permeability of copper µ = 1; 
Conductivity of copper σ = 5.6·107 S/m; 
Magnetic permeability of coating µ = 100; 
Conductivity of copper σ = 1.0·106 S/m; 
Current in the conductors I = 1 A; 
Frequency f = 100 Hz. 

Problem: 
Determine current distribution within the conductors and the coating, complex 
impedance of the line, and power losses in the coating. 

Solution: 
We assume that the flux is contained within the coating, so we can put a Dirichlet 
boundary condition on the outer surface of the coating. See HMagn2.pbm problem in 
the Examples folder for the complete model. 
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The complex impedance per unit length of the line can be obtained from the equation 

Z
V V

I
=

−1 2 , 

where V1 and V2 are voltage drops per unit length in each conductor. These voltage 
drops are equal with opposite signs due to the symmetry of the model. To obtain an 
impedance choose Impedance Wizard from View menu or double click it in the 
calculator tree and then seelct both Conductor 1 and Conductor 2 items in the 
conductors list. 

The impedance of the line Z = 4.87·10-4 + i 7.36·10-4 Ohm/m. 

To obtain power losses in the coating: 

1. In the postprocessing mode, choose Integral Values from View menu. Then 
switch on contour editing mode using Pick Elements command from Contour 
menu and pick the coating block to create the contour. 

2. Double click on Joule heat item in the list of integral quantities or click the gray 
button to the left of it. 

The power losses in the coating P = 4.28·10-5 W/m. 
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Electrostatic Problems 
Elec1: Microstrip Transmission Line 
A shielded microstrip transmission line consists of a substrate, a microstrip, and a 
shield. 

Problem Type: 
Plane-parallel problem of electrostatics. 

Geometry: 
The transmission line is directed along z-axis, its cross section is shown on the sketch. 
The rectangle ABCD is a section of the shield, the line EF represents a conductor 
strip. 

C
10

1
10

BA

D

Air

Substrate

1
E F

 

Given: 
Relative permittivity of air ε = 1; 
Relative permittivity of substrate ε = 10. 
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Problem: 
Determine the capacitance of a transmission line. 

Solution: 
There are several different approaches to calculate the capacitance of the line: 

• To apply some distinct potentials to the shield and the strip and to calculate the 
charge that arises on the strip; 

• To apply zero potential to the shield and to describe the strip as having constant 
but unknown potential and carrying the charge, and then to measure the potential 
that arises on the strip. 

Both these approaches make use of the equation for capacitance: 

C
q
U

= . 

Other possible approaches are based on calculation of stored energy of electric field. 
When the voltage is known: 

C
W

U
=

2
2

, 

and when the charge is known: 

C
q
W

=
2

2
 

Experiment with this example shows that energy-based approaches give little bit less 
accuracy than approaches based on charge and voltage only. The first approach needs 
to get the charge as a value of integral along some contour, and the second one uses 
only a local value of potential, this approach is the simplest and in many cases the 
most reliable. 

The first and third approaches are illustrated in the Elec1_1.pbm problem in the 
Examples folder, and the Elec1_2.pbm explains the second and the fourth approaches. 

Results: 
Theoretical result:  C = 178.1 pF/m. 
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Approach 1:  C = 177.83 pF/m (99.8%). 

Approach 2:  C = 178.47 pF/m (100.2%). 

Approach 3:  C = 177.33 pF/m (99.6%). 

Approach 4:  C = 179.61 pF/m (100.8%). 

See Tutorial topic in online Help for detailed step-by-step instructions for this 
example. 
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Elec2: Two Conductor Transmission Line 

Problem Type: 
A plane problem of electrostatics. 

Geometry: 

Conductors

Dielectric
Ground

Air

 

The problem's region is bounded by ground from the bottom side and extended to 
infinity on other three sides. 

Given: 
Relative permittivity of air ε = 1; 
Relative permittivity of dielectric ε = 2. 

Problem: 
Determine self and mutual capacitance of conductors. 

Solution: 
To avoid the influence of outer boundaries, we'll define the region as a rectangle large 
enough to neglect side effects. To calculate the capacitance matrix we set the voltage 
U = 1 V on one conductor and U = 0 on the another one. 

Self capacitance: C C
Q
U11 22

1

1

= = ; 
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Mutual capacitance: C C
Q
U12 21

2

1

= = ; 

where charge Q1 and Q2 are evaluated on rectangular contours around conductor 1 
and 2 away from their edges. We chose the contours for the C11 and C12 calculation to 
be rectangles −6 ≤ x ≤ 0, 0 ≤ y ≤ 4 and 0 ≤ x ≤ 6, 0 ≤ y ≤ 4 respectively. 

Comparison of Results 
 

 C11 (F/m) C12 (F/m) 

Reference 9.23·10−11 −8.50·10−12 

QuickField 9.43·10−11 −8.57·10−12 

Reference 
A. Khebir, A. B. Kouki, and R. Mittra, "An Absorbing Boundary Condition for 
Quasi-TEM Analysis of Microwave Transmission Lines via the Finite Element 
Method", Journal of Electromagnetic Waves and Applications, 1990. 

See the Elec2.pbm problem in the Examples folder. 
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Steady State Heat Transfer Problems 
Heat1: Slot of an Electric Machine 
Temperature field in the stator tooth zone of power synchronous electric machine. 

Problem Type: 
The plane-parallel problem of heat transfer with convection. 

Geometry: 

10
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20
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17

29

69

2.
5

ø15

wedge

copper
  bars

insulation

cooling duct

steel

 

All dimensions are in millimeters. Stator outer diameter is 690 mm. Domain is a 
10-degree segment of stator transverse section. Two armature bars laying in the slot 
release ohmic loss. Cooling is provided by convection to the axial cooling duct and 
both surfaces of the core.  
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Given: 
Specific copper loss: 360000 W/m3; 
Heat conductivity of steel: 25 J/K·m; 
Heat conductivity of copper: 380 J/K·m; 
Heat conductivity of insulation: 0.15 J/K·m; 
Heat conductivity of wedge: 0.25 J/K·m; 

Inner stator surface: 

Convection coefficient: 250 W/K·m2; 
Temperature of contacting air: 40°C. 

Outer stator surface: 

Convection coefficient: 70 W/K·m2; 
Temperature of contacting air: 20°C. 

Cooling duct: 

Convection coefficient: 150 W/K·m2; 
Temperature of contacting air: 40°C. 

See the Heat1.pbm problem in the Examples folder. 
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Heat2: Cylinder with Temperature Dependent 
Conductivity 
A very long cylinder (infinite length) is maintained at temperature Ti along its internal 
surface and To along its external surface. The thermal conductivity of the cylinder is 
known to vary with temperature according to the linear function λ(T) = C0 + C1⋅T. 

Problem Type: 
An axisymmetric problem of nonlinear heat transfer. 

Geometry: 

R1
0

R5

 

Given: 
Ri = 5 mm, Ro = 10 mm; 
Ti = 100°C, To = 0°C; 
C0 = 50 W/K·m, C1 = 0.5 W/K·m. 

Problem: 
Determine the temperature distribution in the cylinder. 

Solution: 
The axial length of the model is arbitrarily chosen to be 5 mm. 
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Comparison of Results 
 

Radius QuickField Theory 

0.6 79.2 79.2 

0.7 59.5 59.6 

0.8 40.2 40.2 

0.9 20.7 20.8 

See the Heat2.pbm problem in the Examples folder. 



142 Chapter 9  Examples 

Transient Heat Transfer Problems 
THeat1: Heating and Cooling of a Slot of an Electric 
Machine 
Changing temperature field in the stator tooth zone of power synchronous electric 
motor during a loading-unloading cycle. 

Problem Type: 
The plane-parallel problem of transient heat transfer with convection. 

Geometry: 
The same as with Heat1 example: 
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Given: 
1. Working Cycle 

We assume the uniformly distributed temperature before the motor was suddenly 
loaded. The cooling conditions supposed to be constant during the heating process. 
We keep track of the temperature distribution until it gets almost steady-state. Then 
we start to solve the second problem �cooling of the suddenly stopped motor. The 
initial temperature field is imported from the previous solution. The cooling condition 
supposed constant, but different from those while the motor was being loaded. 

2. Material Properties 
 Heat Conductivity 

(J/K·m) 
Specific Heat 

 (J/K·m) 
Mass Density  

(kg/m3) 
Steel Core 25 465 7833 
Copper Bar 380 380 8950 
Bar Insulation 0.15 1800 1300 
Wedge 0.25 1500 1400 

3. Heat Sources and Cooling Conditions 
 Loading Stopped 

Initial Temperature 
The entire model 0 (°C) As calculated at the end of 

loading phase 
Heat Sources 

Specific power 
loss in copper bars 
(W/m3) 

360000 0 

Cooling Conditions 

 Convection 
coefficient 
(W/K·m2) 

Temperature of 
contacting air 
(°C) 

Convection 
coefficient 
(W/K·m2) 

Temperature of 
contacting air 
(°C) 

Inner stator 
surface 

250 40 20 40 

Outer stator 
surface 

70 20 70 20 

Cooling duct 150 40 20 40 
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Solition: 
Each phase of the loading cycle is modeled by a separate QuickField problem. For the 
loading phase the initial temperature is set to zero, for the cooling phase the initial 
thermal distribution is imported from the final time moment of the previous solution. 

Moreover, we decide to break the cooling phase into two separate phases. For the first 
phase we choose time step as small as 100 s, because the rate of temperature change 
is relatively high. This allows us to see that the temperature at the slot bottom first 
increases by approximately 1 grad for 300 seconds, and then begins decreasing. The 
second stage of cooling, after 1200 s, is characterized by relatively low rate of 
temperature changing. So, we choose for this phase the time step to be 600 s. 

For the heating process, the time step of 300 sec is chosen. 

Please see following problems in the Examples folder: 

• THeat1Ld.pbm for loading phase, and 
• THeat1S1.pbm for the beginning of stopped phase, and 
• THeat1S2.pbm for the end of stopped phase 

Results: 
Temperature vs. time dependence at the bottom of the slot (where a temperature 
sensor usually is placed). 

loading stopped
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THeat2: Temperature Response of a Suddenly Cooled 
Wire 
Determine the temperature response of a copper wire of diameter d, originally at 
temperature To, when suddenly immersed in air at temperature Ti. The convection 
coefficient between the wire and the air is α. 

Problem Type: 
A plane-parallel problem of transient heat transfer with convection. 

Geometry: 

T(0) = T0

α, Ti

c, ρ, λ Model

 

Given: 
d = 0.015625 in; 
Ti = 37.77°C, To = 148.88°C; 
C = 380.16 J/kg·K, ρ = 8966.04 kg/m3; 
α = 11.37 W/K·m2. 
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Problem: 
Determine the temperature in the wire. 

Solution: 
To set the non-zero initial temperature we have to solve an auxiliary steady state 
problem, whose solution is uniform distribution of the temperature T0 

The final time of 180 sec is sufficient for the theoretical response comparison. A time 
step of 4.5 sec is used. 

Comparison of Results 
 

Temperature, C 

Time QuickField ANSYS Reference 

45 sec 91.37 91.38 89.6 

117 sec 54.46 54.47 53.33 

180 sec 43.79 43.79 43.17 

See the THeat2.pbm (main) and THeat2_i.pbm (auxiliary) problems in the Examples 
folder. 

Reference 
Kreif F., "Principles of Heat Transfer", International Textbook Co., Scranton, 
Pennsylvania, 2nd Printing, 1959, Page 120, Example 4-1. 
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THeat3: Transient Temperature Distribution in an 
Orthotropic Metal Bar  
A long metal bar of rectangular cross-section is initially at a temperature To and is 
then suddenly quenched in a large volume of fluid at temperature Ti. The material 
conductivity is orthotropic, having different X and Y directional properties. The 
surface convection coefficient between the wire and the air is α. 

Problem Type: 
A plane-parallel problem of transient heat transfer with convection. 

Geometry: 

λx, λy, ρ, c
X

Y a

b

α, Ti

T(0) = T0

Model

 

Given: 
a = 2 in, b = 1 in 
λx = 34.6147 W/K·m,  λy = 6.2369 W/K·m; 
Ti = 37.78°C,   To = 260°C; 
α = 1361.7 W/K·m2; 
C = 37.688 J/kg·K,  ρ = 6407.04 kg/m3. 
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Problem: 
Determine the temperature distribution in the slab after 3 seconds at the center, corner 
edge and face centers of the bar. 

Solution: 
To set the non-zero initial temperature we have to solve an auxiliary steady state 
problem, whose solution is uniform distribution of the temperature T0 

A time step of 0.1 sec is used. 

Comparison of Results 
 

Temperature, C 

Point QuickField ANSYS Reference 

(0,0) in 238.7 239.4 237.2 

(2,1) in 66.43 67.78 66.1 

(2,0) in 141.2 140.6 137.2 

(0,1) in 93.8 93.3 94.4 

See the THeat3.pbm (main) and THeat3_i.pbm (auxiliary) problem in the Examples 
folder. 

Reference 
Schneider P.J., "Conduction Heat Transfer", Addison-Wesley Publishing Co., Inc, 
Reading, Mass., 2nd Printing, 1957, Page 261, Example 10-7. 
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Stress Analysis Problems 
Stres1: Perforated Plate 
A thin rectangular sheet with a central hole subject to tensile loading. 

Problem Type: 
Plane problem of stress analysis (plane stress formulation). 

Geometry of the plate: 
Length: 240 mm; 
Width: 180 mm; 
Radius of central opening: 30 mm; 
Thickness: 5 mm. 

24
0

180

30

Model

 

Given: 
Young's modulus E = 207000 N/mm2; 
Poisson's ratio ν = 0.3. 

The uniform tensile loading (40 N/mm2) is applied to the bottom edge of the structure. 
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Problem: 
Determine the concentration factor due to presence of the central opening. 

Solution: 
Due to mirror symmetry one quarter of the structure is presented, and internal 
boundaries are restrained in X and Y directions respectively. 

The concentration factor may be obtained from the loading stress (40 N/mm2) and the 
maximum computed stress (146 N/mm2) as 

k = 146 / 40 = 3.65. 

See the Stres1.pbm problem in the Examples folder. 



  Coupled Problems 151 

Coupled Problems 
Coupl1: Stress Distribution in a Long Solenoid 
A very long, thick solenoid has an uniform distribution of circumferential current. 
The magnetic flux density and stress distribution in the solenoid has to be calculated. 

Problem Type: 
An axisymmetric problem of magneto-structural coupling. 

Geometry: 
R2R1

 

Given: 
Dimensions Ri = 1 cm, Ro = 2 cm; 
Relative permeability of air and coil µ = 1; 
Current density j = 1·105 A/m2; 
Young's modulus E = 1.075·1011 N/m2; 
Poisson's ratio ν = 0.33. 

Problem: 
Calculate the magnetic flux density and stress distribution. 
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Solution: 
Since none of physical quantities varies along z-axis, a thin slice of the solenoid could 
be modeled. The axial length of the model is arbitrarily chosen to be 0.2 cm. Radial 
component of the flux density is set equal to zero at the outward surface of the 
solenoid. Axial displacement is set equal to zero at the side edges of the model to 
reflect the infinite length of the solenoid. 

Comparison of Results 
Magnetic flux density and circumferential stress at r = 1.3 cm: 

 Bz (T) σθ (N/m2) 

Reference 8.796·10-3 97.407 

QuickField 8.798·10-3 96.71 

Reference 
F. A. Moon, "Magneto-Solid Mechanics", John Wiley & Sons, N.Y., 1984, Chapter 4. 

See the Coupl1MS.pbm and Coupl1SA.pbm problems in the Examples folder for 
magnetic and structural parts of this problem respectively. 

Also see Tutorial topic in online Help for detailed step-by-step instructions for this 
example. 
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Coupl2: Cylinder Subject to Temperature and Pressure 
A very long, thick-walled cylinder is subjected to an internal pressure and a steady 
state temperature distribution with Ti and To temperatures at inner and outer surfaces 
respectively. Calculate the stress distribution in the cylinder. 

Problem Type: 
An axisymmetric problem of thermal-structural coupling. 

Geometry: 
R2R1

 

Given: 
Dimensions Ri = 1 cm, Ro = 2 cm; 
Inner surface temperature Ti = 100°C; 
Outer surface temperature To = 0°C; 
Coefficient of thermal expansion α = 1·10−6 1/K; 
Internal pressure P = 1⋅106 N/m2; 
Young's modulus E = 3⋅1011 N/m2; 
Poisson's ratio ν = 0.3. 

Problem: 
Calculate the stress distribution. 
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Solution: 
Since none of physical quantities varies along z-axis, a thin slice of the cylinder can 
be modeled. The axial length of the model is arbitrarily chosen to be 0.2 cm. Axial 
displacement is set equal to zero at the side edges of the model to reflect the infinite 
length of the cylinder. 

Comparison of Results 
Radial and circumferential stress at r = 1.2875 cm: 

 σr (N/m2) σθ (N/m2) 

Theory −3.9834⋅106 −5.9247⋅106 

QuickField −3.959⋅106 −5.924⋅106 

Reference 
S. P. Timoshenko and Goodier, "Theory of Elasticity", McGraw-Hill Book Co., N.Y., 
1961, pp. 448-449. 

See the Coupl2HT.pbm and Coupl2SA.pbm problems in the Examples folder for the 
corresponding heat transfer and structural parts of this problem. 
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Coupl3: Temperature Distribution in an Electric Wire 
Calculate the temperature distribution in a long current carrying wire. 

Problem Type: 
An axisymmetric problem of electro-thermal coupling. 

Geometry: 

 

Given: 
Wire diameter d = 10 mm; 
Resistance R = 3·10−4 Ω/m; 
Electric current I = 1000 A; 
Thermal conductivity λ = 20 W/K·m; 
Convection coefficient α = 800 W/K·m2; 
Ambient temperature To = 20°C. 

Problem: 
Calculate the temperature distribution in the wire. 

Solution: 
We arbitrary chose a 10 mm piece of wire to be represented by the model. For data 
input we need the wire radius r = 5 mm, and the resistivity of material: 
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ρ
π

= = ⋅ ⋅−d R2
8

4
2 356 10. ( )Ω m , 

and voltage drop for our 10 mm piece of the wire: 

∆U = I⋅R⋅l = 3·10−3 (V). 

For the current flow problem we specify two different voltages at two sections of the 
wire, and a zero current condition at its surface. For heat transfer problem we specify 
zero flux conditions at the sections of the wire and a convection boundary condition at 
its surface. 

Comparison of Results 
Center line temperature: 

 T (°C) 

Theory 33.13 

QuickField 33.14 

Reference 
W. Rohsenow and H. Y. Choi, "Heat, Mass, and Momentum Transfer", Prentice-Hall, 
N.J., 1963. 

See the Coupl3CF.pbm and Coupl3HT.pbm problems in the Examples folder for the 
corresponding current flow and heat transfer parts of this problem. 
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Coupl4: Tokamak Solenoid 
The central solenoid of the ohmic heating system for a tokamak fusion device. 

Problem Type: 
An axisymmetric problem of magneto-structural coupling. 

Geometry: 

360

ø4
0

ø1
56

 

The solenoid consists of 80 superconducting coils fixed in common plastic structure. 
Due to mirror symmetry one half of the structure is modeled. 

Given: 
Data for magnetic analysis: 

Current density in coils j = 3·108 A/m2; 
Magnetic permittivity of plastic, coils and liquid helium inside coils µ = 1. 

Data for stress analysis: 

Copper of coils: 

Young's modulus E = 7.74·1010 N/m2; 
Poisson's ratio ν = 0.335; 
Maximum allowable stress: 2.2·108 N/m2. 



158 Chapter 9  Examples 

Plastic structure: 

Young's modulus E = 2·1011 N/m2; 
Poisson's ratio ν = 0.35; 
Maximum allowable stress: 1·109 N/m2. 

In the Examples folder the Coupl4MS.pbm is the problem of calculating the magnetic 
field generated by the solenoid, and Coupl4SA.pbm analyzes stresses and 
deformations in coils and plastic structure due to Lorentz forces acting on the coils. 
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color map  67 
conductivity 

electric  See electric resistivity 
thermal  15 

conductor 
connected in series  42, 45, 95, 103 

contour editing  81 
convection  50, 119 
coordinates 

Cartesian  23 
polar  23 

copying 
field pictures  91 
local field data  73 
model pictures  36 
X-Y plots  91 

coupled problems  129 
coupling  21 
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electro-structural  14, 131 
electro-thermal  13, 15, 130 
electro-thermal, example  163 
initial thermal state  16 
magneto-structural  12, 13, 14, 131 
magneto-structural, example  159 
thermo-structural  15, 53, 130 
thermo-structural, example  161 

creating 
edge  27 
label  40 
model  26 
problem  20 
vertex  27 

criterion 
Drucker-Prager  53, 66, 128 
Hill  53, 67, 128 
Mohr-Coulomb  53, 66, 128 
Tresca  66, 128 
von Mises  66, 127 

current  11, 42 
alternating  12, 101 
eddy  12, 64, 102, 106 
source  12, 64, 102, 104, 106 
total  12, 64, 106 

current densisty  42 
current density  11, 12, 13, 14, 41, 44, 65, 94, 102, 

113�16, 131 
surface  97, 105 
units of  23 
volume  94, 95, 102 

current flow analysis  14, 113 
data for  48 
example  163 

curve editing  54 

D 
data 

current flow  48 
electrostatics  46 
heat transfer  49 
magnetostatics  41 
stress analysis  51 
time-harmonic magnetics  44 

dcf(current flow data) files  19 
deformed shape  68 
des (electrostatic data) files  19 
dhe (harmonic electromagnetic data) files  19 
dht (heat transfer data) files  19 

dielectric constant  See electric permittivity 
Dirichlet boundary condition  11, 13, 95, 96, 97, 

104, 105, 110, 114 
displacement  16, 66, 71, 121, 127 

boundary condition  53, 54 
prescribed  16 
units of  23 

dms (magnetostatic data) files  19 
Drucker-Prager criterion  53, 66 
dsa (stress analysis data) files  19 
DXF file export  35 
DXF file import  35 

E 
eddy current  12, 64, 102, 106 
edge  25, 26, 93, 97, 105 

and boundary condition  95, 104, 110, 111, 
114, 118, 127 

and boundary condition  96, 104 
and current flow data  49 
and electric charge  109 
and electric current  114 
and electrostatic data  47 
and heat source  117 
and heat transfer data  50 
and magnetic data  43, 45 
and stress analysis data  53 
copying  28 
creating  27, 30 
deleting  30 
direction of  126 
labeling  31 

editing 
contour  81 
curve  54 
label data  41 
model  25�36 
problem  20 

electric charge  13, 78, 85, 86, 109, 112 
electric conductivity  44 
electric conductivity  See also electric resistivity 
electric conductor  12 
electric current  14, 15, 85, 87, 89, 94, 95, 97, 100, 

102, 103, 105, 113�16 
volume  95 

electric field intensity  63, 65, 109�12, 115 
gradient of  64 

electric induction  110, 111 
electric motor  11, 12 
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example  141 
electric permittivity  13, 46, 64, 109, 111 
electric potential 

boundary condition  110, 114 
electric potential  63, 65, 109, 111, 112, 113, 115 
electric resistivity  14, 48, 65, 114, 116 
electrostatic analysis  13, 109 

data for  46 
example  148, 151 

electrostatic force  14, 16, 86, 112, 129, 131 
emissivity coefficient  119 
energy 

of deformation  66 
of electric field  14, 64, 78, 86, 112 
of electric field, example  149 
of magnetic field  12, 13, 64, 65, 74, 87, 88, 99, 

106, 107 
example problems  133 
exporting 

DXF file  35 

F 
field  31 

lines  68 
magnetic  94, 97, 98, 105 
magnetic, uniform external  11, 12, 96, 104 
picture  67, 71 
picture, constructing  69 
presentation methods  67 
source  26, 39, 85, 93, 95, 103, 109, 114 

field picture 
copying  91 
printing  90 

film coefficient  See coefficient of convection 
floating conductor  14, 111 
flux density  11, 12, 13, 54, 64, 65, 94, 96, 98, 102, 

104, 106 
flux lines  68 
flux linkage  11, 12, 76, 86, 87, 99, 100 
force  85 

electrostatic  14, 16, 21, 86, 112, 129, 131 
Lorentz  131 
magnetic  11, 12, 13, 16, 21, 86, 88, 99, 107, 

129, 131 
magnetic, example  136 

frequency  101, 102 

G 
geometric objects 

copying  28 
moving  29 
selecting  28 

getting started  3 

H 
hardware  3 
harmonic magnetics  See time-harmonic 

electromagnetic analysis 
heat 

specific  15 
heat conductivity  117 

very high  119 
heat flow  65 
heat flux  15, 50, 85, 89, 118, 120 

boundary condition  118 
heat source  13, 15, 49, 50, 51, 117, 119 

temperature dependent  50 
heat transfer  13, 15, 21, 116 

data for  49 
example  153 
example, nonlinear  155 
transient  15 

Hill criterion  53, 67, 128 
hydrostatic pressure  126 

I 
impedance  12, 13, 74, 80, 108. See also inductance 
impedance calculation, example  145, 147 
impedance wizard  13, 80 
importing 

data  21 
DXF file  35 
electrostatic forces to stress analysis  131 
Joule heat to heat transfer analysis  130 
magnetic forces to stress analysis  131 
temperatures to stress analysis  130 

inductance  12, 13, 74, 100, 108. See also 
impedance and flux linkage 

inductance wizard  12, 13, 74 
inductor  12 
installation  3 
integral quantities  85, 99, 106, 112, 116, 120 
interpreted quantities  63 
isolated conductor  See floating conductor 
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isotherm  68 
isotropic material  16, 122, 123, 124, 125, 126 

J 
Joule heat  13, 65, 88, 106, 107, 116, 129. See also 

power losses 

L 
label  25, 26, 59 

assigning data to  40 
assigning to geometric objects  31 
copying data  56 
deleting data  56 
editing data  41 
renaming  56 

legend  90 
loading  See also field source 

current flow analysis  14 
electrostatics  13 
force  16, 126 
harmonic magnetics  12 
heat transfer analysis  15 
magnetostatics  11 
pressure  16, 126 
thermal  16, 71, 124 

local field data  73 
copying to clipboard  73 

Lorentz force  65, 106, 131 

M 
magnetic field intensity  11, 12, 13, 54, 64, 65, 97, 

99, 105, 106 
magnetic force  11, 13, 16, 86 

example  136 
magnetic permeability  11, 12, 41, 42, 44, 64, 65, 

94, 98, 99, 102, 106 
magnetic potential  11, 13, 64, 94�100, 102 
magnetostatic analysis  11, 94 

data for  41 
example  134 

material 
isotropic  16, 122, 123, 124, 125, 126 
orthotropic  11, 12, 13, 14, 15, 16, 67, 123, 124, 

125, 126, 128 
memory  3, 60 
mesh  26, 27, 59 

building  31, 32, 33 
deleting  33 
density  27, 31 
nonuniform  31 
spacing  25, 26, 31, 32, 34 
visibility  33, 34 
visibility options  34 

mod (model) files  19 
model 

creating  26 
editing  25�36 
geometry  25 
plane of  93 
printing  35 
view options  34 

model editor  23 
model picture 

copying  36 
Mohr-Coulomb criterion  53, 66 

N 
Neumann boundary condition  11, 13, 95, 96, 97, 98, 

103, 105, 109, 110, 115, 118 

O 
ohmic losses  See power losses 
orthotropic material  11, 12, 13, 14, 15, 16, 67, 123, 

124, 125, 126, 128 

P 
password  4 
pbm (problem description) files  19 
peak value  101 
permanent magnet  11, 41, 94, 95, 97, 98, 102 

equivalent current  98 
equivalent current, example  139 
example  139, 141 
example, nonlinear  134 

phase angle  101 
physical quantities  98, 106, 115 

heat transfer  120 
stress analysis  127 

plane strain  16, 93, 120, 125 
plane stress  16, 93, 120, 122, 123, 125, 127 
Poisson's ratio  124 
polar coordinates  23 
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polarization 
coefficient of  101 
linear  101 

power losses  12, 13, 14, 15, 21, 65, 89, 106, 107 
Poynting vector  65, 88, 106, 107 
pressure  16, 53 
principal stress  16, 66, 68, 127, 128 
printing 

field pictures  90 
models  35 
X-Y plots  90 

problem 
creating  20 
data  39 
database  19 
description  19 
editing  20 
solving  59 

R 
radiation  51, 119 
remanent induction  98 
res (results) files  20 
resistivity  14, 48, 65, 114, 116 

S 
selecting 

geometric objects  28 
vertices  32 

serial conductor  42, 45, 95, 103 
shear modulus  124 
solenoid  11, 12 

example  136, 159, 165 
source current  12, 64, 102, 104, 106 
specific heat  117 
specific heat  15 
spiral coil  95, 103 
Stephan-Boltsman constant  119 
strain  16, 66, 121 

thermal  16, 122, 124 
stress  16, 66, 71, 122, 125 

allowable  66, 128 
principal  16, 66, 68, 127, 128 
tensor  68 
thermal  15 
von Mises  66, 127 

stress analysis  12, 13, 16, 21, 51, 70, 93, 120 
data for  51 

example  157 
presentation methods  68 
with imported loads  129, 130, 131 

superconductor  11, 13, 97, 105 

T 
tables 

in postprocessor  89 
temperature  15, 21, 49, 54, 65, 116�20, 129 

ambient, for convection  119 
ambient, for radiation  119 
boundary condition  51 
difference  71 

termal conductivity  65 
terminology  9, 25 
theoretical description  93 
thermal conductivity  15, 54 

temperature dependent  49 
thermal loading  53, 71, 124 
thermal loading, example  161 
thermal strain  16, 122, 124 
thermal stress  15 
time-harmonic electromagnetic analysis  12, 70, 101 

data for  44 
example  144, 146 

tokamak  165 
torque  85 

of electrostatic forces  14, 86, 112 
of magnetic forces  11, 12, 13, 87, 88, 99, 107 

total current  12, 64, 106 
transient heat transfer  15 
transmission line, example  148, 151 
Tresca criterion  66, 128 

U 
uninstall  4 
units of length  23 

V 
vertex  25, 26, 94, 95, 103 

and boundary condition  95, 104, 114, 118, 127 
and current flow data  49 
and electric charge  109 
and electric current  114 
and electrostatic data  47 
and heat source  117 
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and heat transfer data  51 
and magnetic data  43, 46 
and mesh spacing  27, 31, 32, 33 
and stress analysis data  54 
copying  28 
creating  27, 30 
deleting  30 
labeling  31 

view options  34 
voltage  12, 13, 44, 103. See electric potential 
von Mises stress  66, 127 

W 
wizard  13, 73 

capacitance  14, 77 
impedance  13, 80 
inductance  12, 13, 74 

X 
X-Y plot 

copying  91 
printing  90 

X-Y plot  83�84 

Y 
Young's modulus  124 

Z 
zooming 

in curve editor  55 
in model editor  33 
in postprocessor  72 
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